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Section 1: Introduction 

Welcome to the Arc Supervisor Connect user guide. The Supervisor Connect is an important 

application of the Arc Connect suite. It is for managing and over seeing the activities of the 

organisation. This organisation purchases the Supervisor application to manage and control the 

activities of the Users in its Call Centre using other applications of the Arc Connect suite.  

 

The Application 

Arc Supervisor allows the users to make on-line updates (changes) to the configuration of the Arc 

applications running already related to Calls, Queues and Users. Supervisors can view reports, 

analyse activities graphically and update the configuration without logging into the Configuration 

utility.  

 

The users are allowed to log on or log off the Users, change their Statuses and modify the 

properties while working in the application. They can enable or disable a Queue, change its 

properties and set the thresholds. The reports are in the graphical and text format. These reports 

have information about Calls, Queues and Users activities. These reports can also be printed. 

 

About the User Guide 

This user guide explains the role of the Supervisor application in an organisation. It describes 

how it plays effectively in relation to the Arc Connect applications and what benefits a Supervisor 

can derive. It also explains how the Supervisors (users) can use the given facilities for managing 

the activities within their telephony system in a better approach. 

 

The Audience 

The user guide is intended for the audience who are, 

1. Involved in the training of the application users. 

2. The application users themselves. 

 

It is assumed that the users have a working knowledge of Microsoft Windows '95, '98, 2000, NT 

and XP. 
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Inside The User Guide  

This User Guide contains the following briefly introduced sections, 

 

Getting Started 

This section gives description on the logging in and logging off the Supervisor application. It 

introduces the users with the Interface and describes its contents according to their functions. It 

gives details about the Menu bar and Tool bar options.  

 

Initialising Supervisor Connect  

In this section, the users learn how to configure the preferences, other required settings and 

adjustments before starting to work in the Supervisor application. It gives step-by-step 

procedures to complete the sequence of functions.  

 

Arc Connect 

This is the main and foremost section that describes the overall functionalities in Supervisor 

application such as the Reports, Graphs and Online updates. It gives collective data on the 

modules it is supervising. The users get to know the functions they can perform to start working 

in the application. It gives details on  

• Creating new Monitor Templates 

• Using the menu and tool bars options of the Monitor Templates 

• Setting Alarms and Thresholds 

• Data Windows, Data Levels, Data Items and Data Statistics 

• Reports and the Graphs 

• Online Updates 

 

Console Connect 

This section is about the reports, graphs and the online updates related to the Console Connect. 

The Supervisor can know the activities taking place in the Console Connect application. 

 

Voice Connect 

In this section, the users are introduced with the reports and graphs of the Voice connect. The 

Voice Connect has no online updates.  
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For the convenience of users, the sections for Glossary, Table of Figures and Index have been 

provided. 

 

There are Appendices, given to impart an in-depth look at many types of reports that can be 

produced by the Supervisor application. There are over 200 reports and charts that can be 

produced by the Arc Supervisor. All reports are run in the same way. The details of specific 

reports can be found in their related Appendixes. 

 

Conventions 

The conventions used in this User Guide are: 

• Tahoma font-face with 10pt font size 

• Heading 1, Heading 2, Heading 3, Heading 4 

• Some of the headings are created, Title, Sub-title, Intro font, Intro font 2 

• The figures are captioned with Tahoma font-face and 8pt font size. 

• Examples, Tips and Notes are given in image forms. 

• Topics are numbered following the number of Sections. 

• Numbered lists are used for procedures and steps. 

• Bulleted lists are used for functionalities. 

• Menu paths and specific application names are in Italics. 

• Menu options and controls are given in bold. 
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Section 2: Getting Started 

The Supervisors are configured in the Users section of the Configuration utility. While creating 

the Supervisors in the Configuration utility, different Arc Connect modules i.e. Console Connect 

and Voice Connect are assigned to them. And different Supervisors can be assigned for one or 

more than one module. Also the Login name and Password for the Supervisor application are 

given to the users in Configuration utility. 

 

2.1 Logging On 

When a Supervisor logs in the application with the given Login Name and Password, it checks 

the modules assigned to the user. Then it displays relevant modules allowed to the Supervisor.  

 

 

A supervisor Daniel is provided with a Login name DAN and Password DAN. 

The Console Connect and Voice Connect are assigned to him while creating 

him as a user in the Configuration utility. When he logs in the Arc Supervisor 

application, the system will display only the Voice Connect and Console 

Connect modules. 

 

 

 

 

 

 

 

 

The first time a user opens the supervisor application; the logging in procedure is as follows, 

Firstly they will be asked to select reporting database. This is the database that will be used to 

generate call reports. 
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2.1.1 Select Reporting Database 

Selecting a SQL Database, 

 

 

 

 

 

1. Click Yes to continue the procedure of selecting a database. 

 

 

 

 

 

 

2. Click Next. 

 

 

 

 

 

 

3. Select a SQL Server from the drop down list. Click Next. 

 

 

 

 

 

 

4. Enter the User Name and Password for the SQL Server. 
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5. Click Next. 

 

 

 

 

 

 

 

6. Select a Log Database from the drop down list. Click Finish. 

 

2.1.2 Logging In 

 

1. The logging window will appear after connecting to the Arc CT Server. 

 

 

 

 

 

Figure 2-1 Logon 

1. Enter the Login Name and Password. 

2. Click Logon to enter the Supervisor application. 

3. The modules allowed to the logged on Supervisor display on the screen. 

 

 

If you have given the Arc CT Server Name and Port Number during the 

installation of the Supervisor application, then you do not need to enter the 

information again while logging in. the application will automatically connect to 

the Arc CT Server. You are shown the Login window only. 
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If the user is not prompted for the Server Name and Port Number, then the following simple 

procedure is taken, 

 

1. Click the icon  in tool bar. 

2. The Login window will open. 

 

 

 

 

 

Figure 2-2 Login window 

3. Enter the Login Name and Password. 

4. Click Logon. 
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2.2 Interface 

On logging the Supervisor application, the contents appearing on the screen are, 

1. Menu Bar 

2. Tool Bar 

3. Message Bar  

4. Supervisor Bar 

5. Folder List 

6. Description Area 

 

 

Figure 2-3 Arc Connect Supervisor’s main interface. 
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2.2.1 Menu Bar 

The options in the menu bar are explained the following the table, 

Control Name Explanation 

File 

Printer Set up This option is to configure settings for printing the reports.  

Log On/ Log Off This option is for logging on and logging off the application. 

Exit This option is to quit the application. 

View 

Supervisor Bar This option is selected by default. To remove the bar from the 

screen, de-select this option. 

This bar contains icons of Monitor Templates, Reports and 

Online Updates. 

Folder List This option is also selected by default. De-select the option to 

remove it from the screen.  

This bar contains the default module Arc Connect. Other modules1 

are the assigned application to the Supervisor. T helps in navigating 

through the modules easily. 

Message Bar Select this option to make the message bar visible on the screen. 

The users can view messages sent by other Supervisors, Users or 

Queues in it. It also shows the set Alarms. 

Database 

Select Reporting 

Database 

This option allows the Supervisor to select the logging database 

(ArcLogDB) for generating reports. 

<<TOC 
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Database Maintenance Supervisor can configure settings for the logging database by using 

this option. 

Message 

Send Supervisor can send message (s) to Wallboard and Supervisor 

application users. 

Configuration 

Preferences This option allows the Supervisor to configure the settings for 

displaying a message. 

It also displays the Server connection details. 

Help 

Contents It helps to find the required topics giving easy navigation to the 

users. 

Keyword Search It allows searching the relevant information by entering keywords in 

Help file. 

About Arc Connect 

Supervisor 

It displays the version and copyright information about the 

Supervisor application. 

Table 2-1 

2.2.2 Tool Bar 

The icons given in the tool bar are explained in the following table, 

Control Name Icon Explanation 

Log On/Log Off 
 

Click to log on to the application. Also click the to log off. 

When a Supervisor logs on, the Green light in the button enables. 

When the Supervisor logs off, the Red light turns on. 

Connect To 

Database 
 

Click icon to connect to the required database. It opens the Select 

Logging Database window. 

Send Message 
 

Click to send message(s) to the Users, Queues, other Supervisors or 

the Entire System.  
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Preferences 
 

Click to configure the settings for displaying messages and the 

Server connection. 

Printer Set up 
 

Click to configure settings for printing reports. 

On-screen Help 
 

Click for help on Supervisor application. 

Run Report 
 

This icon enables only when the reports are selected. Click to run a 

report. 

Table 2-2 

2.2.3 Message Bar 

It displays the messages sent by other users. It also displays the Alarm messages set by the 

Supervisor in the Set Thresholds window of the Monitor Templates. 

The Alarm messages display in the Message Bar in addition to a popup window in the system 

tray. 

2.2.4 Supervisor Bar 

This bar has the icons for  

1. Monitor Templates 

2. Reports 

3. Online Updates 

The Supervisor Bar contains slides for every modules assigned to the user(s). It gives quick 

access to the above numbered contents of the modules. 

2.2.5 Folder List 

It displays the modules in a folder format. The navigation is in a tree style. It allows the 

Supervisor to navigate quickly and see the contents of particular folder(s). The files and folders 

can be expanded or contracted by clicking on  or  icons to view the sub-folders and reports. 
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2.2.6 Description Area 

This area shows the contents of the selected folders in the Folder List or Supervisor Bar. The 

contents include the list of reports and graphical analysis and the folders for online updates. 

 

When a graph or report is selected in the Description Area, it instantly displays the required 

input options for it. 

2.3 Database 

Arc Supervisor application takes information from the Logging Database file, ArcLogDB to run 

the reports. This database is installed with the Server application. Upon first use of the 

Supervisor application, it will prompt for the database connection, which then becomes the 

default database. User can always change the Logging Database by using the Select Reporting 

Database option.  

2.4 Arc Connect Suite Support 

Arc Supervisor application provides the ability to support and manage the Arc Connect products, 

1. Console Connect 

2. Voice Connect 

2.4.1 Console Connect 

The users can view the Historical and Real-time statistics. The Historical reports include the 

Graphical Analysis and Text-based Reports, whereas the Real-time reports are visual reports 

displayed instantaneously. Users can make on-line changes to the active configuration for 

Console Connect.  

2.4.2 Voice Connect 

This module provides with Graphical Analysis and Text-based Reports only. The users are unable 

to make online changes to this module. 

<<TOC 
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Section 3: Initialising Supervisor Connect 

Arc Connect Supervisor application has functions and procedures that can be easily performed to 

initialise and work with. The users are allowed to set preferences for various functions. 

 

This section explains the following, 

• Print Set up 

• Logging On/Off 

• Database Configuration 

• Message 

• Configuration-Preferences 

 

3.1 File 

3.1.1 Print Set up 

In this window, the users can set options for printing the reports. It has three sections 

Printer: The user can select a printer on network. The other options display information 

about the selected printer. It also has a Properties button. Click to select or change 

properties for the printout. 

 

Paper: Users can select a paper size from 

the drop down list and also the source of 

the paper. 

Orientation: It allows the user to select 

the type of printout is required, either 

Portrait or Landscape. 

 

 

 

Figure 3-1 Set up printer settings 

The Network button allows user to select a printer on the network. 
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To configure the printer settings, perform the following steps, 

1. Select Name of the printer installed. 

2. Select paper Size. 

3. Select a Source.  

4. Select an option from the Orientation, either Portrait or Landscape. 

5. Click Ok. 

For printer set up you can also click the  icon on the toolbar. 

3.1.2 Log On/Log Off 

The Log On/Off procedure is same as given in section 1.2 Logging On.  

3.1.3 Exit 

Select this option to quit the application. 

3.2 View 

The options in this menu are Supervisor Bar, Folder List and Message Bar. All these options 

are selected by default in the application. Although they display by default, if any option is 

invisible, select the required one.  

 

A supervisor wants the Message Bar to appear on the screen.

1. Click on the View menu. 

2. Select Message Bar option. 

 

 

 

 

 

3.3 Database 

This menu has three options for selecting and managing the databases. 

3.3.1 Select Reporting Database 

To generate reports in the Supervisor application, the system requires a logging database to 

connect to. Supervisor can change the database when required.  
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Selecting a SQL Database 

1. Click Select Reporting Database option from the menu. The following window will 

open. 

 

 

 

 

 

 

2. Click Next. 

 

 

 

 

 

 

3. Select a SQL Server from the drop down list. Click Next. 

 

 

 

 

 

 

4. Enter the User Name and Password for the SQL Server. 

5. Click Next. 

 

 

 

 

 

 

6. Select a Log Database from the drop down list. Click Finish. 
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You can also browse a database by clicking  icon on the tool Bar. If the logging database is 

not selected for the application, the system prompts for a database during the logging in. In this 

case, the system displays a message, 

 

 

 

 

Click Yes to continue the procedure of selecting a database. 

3.3.2 Database Maintenance 

The Supervisor can change settings for the Logging database through this option. The Database 

Maintenance consists of two tabs, Log Database and Tools.  

 

Log Database 

The Log Database tab allows the Supervisor to  

• Set the free space required on the hard disk. 

If the free disk space is left less than that, 

then system will raise a warning. 

• View the Free Space available on Hard disk. 

• View the Database size.  

 

 

 

 

Figure 3-2 View the Disk space 
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Tools 

It allows Supervisor to  

• View the Status of the server. 

• Select a Mode for the server. 

• Compact the logging database if required. 

 

 

 

 

 

 

Figure 3-3 Use Tools as required 

3.4 Message 

3.4.1 Send 

The Supervisor can send messages to other users in the system. Selecting this option displays 

the following Send Message window, 

 

 

 

 

 

 

 

 

Figure 3-4 Send a message 

To send a message, 

1. Select a Destination Type from the drop down list. 

2. The Recipient list box will display all the names of the users in that particular 

destination. 
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3. Select the user’s name you want to send a message. 

4. Type a Message. 

5. Click Send to send the message to the user. 

 

The message can be sent to more than one user. To quit sending messages, click Exit. To send 

a message you can also click the  icon on the toolbar. 

 

3.5 Configuration 

The Configuration section has two sub menu options. 

1. Preferences 

3.5.1 Preferences 

The Supervisor can modify the settings for the Message Bar display and view the Server 

Connection details. 

 

This window has two tabs that are explained below, 

 

Environment 

This tab allows the users to modify the message display settings.  

 

Figure 3-5 Modify message settings 
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To modify the message bar settings 

 

1. Click Background. 

2. Select a colour from the palette. 

3. Select Text colour. 

4. Set the Scroll Speed. 

5. Click Ok. 

 

Figure 3-6 Select colours 

Supervisor can also modify the background colour of the Supervisor Bar, Folder List and the 

Description Pane, in the background colour section. 

1. Click the Change button. 

2. Select a colour from the palette. 

3. Click Ok. 

 

Server Connection 

This tab displays the status of the connected server. 

 

 

 

 

 

 

 

 

Figure 3-7 View Server Connection 

You can only view the server details. 
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3.6 Message Bar 

The Message Bar keeps the users aware and alert of the occurring tasks in the organization (Call 

Centre). It also shows the Alarm Messages triggered when thresholds exceed. It is able to 

receive messages from the Users, Queues and Supervisors.  

 

Right-click on the Message Bar, a drop-down menu will appear. The options are, 

1. Clear All Messages 

2. Clear Message 

3. Attached 

4. Floating 

5. System Tray 

 

The user can set preferences for the messages from these options. The drop down menu 

appears as shown in the figure below. 

 

 

Figure 3-8 Select option for Message Bar 

3.6.1 Clear All Messages 

A Message Bar can display more than one message. All the messages keep scrolling in the bar 

until the user requires removing them. Select the Clear All Messages to clear all messages 

scrolling in the bar.  

3.6.2 Clear Message 

If one message is scrolling in the bar, then user can select this option to clear it. 
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1. Click on the Clear Message option. 

2. The option will show a menu for the messages floating on the message bar at that time. 

3. Click on the message required removing from the bar. 

3.6.3 Attached 

This option is selected by default. The Message Bar is attached to the Tool Bar. 

3.6.4 Floating 

If the user wants to have a floating message bar, select this option. The message bar will stand-

alone on the screen. 

 

 

Figure 3-9 Floating Bar 

If the Supervisor closes the floating message bar, it will minimise in the System Tray. The 

floating message bar can be retrieved any time. 

3.6.5 System Tray 

If this option is selected, the message bar minimised in the System Tray. The icon in the System 

Tray is . The message bar can be retrieved any time with a double click. 
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Section 4: Arc Connect 

Arc Connect is the first and default opened module folder of the application. It is in both the 

Supervisor Bar and Folder List. The Arc Connect folder contains three segments, 

1. Monitor Templates 

2. Reports 

3. Online Updates 

It gives figured up Reports and Online Updates related to the modules available to the logged on 

user(s). The reports give details about the Total Incoming and Outgoing calls; the Routing calls, 

CLI tracking, DDI tracking and External transfer calls. The On line Updates allow the Supervisor 

to make instant changes to the configurations such as Main Directory, Users, and Reason 

Codes. 

 

4.1 Arc Connect Monitor Templates 

The Monitor Templates consist of Data Windows that allows the users to manage the activities.  

Figure 4-1 Create a New Template 

Double click on Create a New Template. A new window will open with System Monitor 

Template displaying in its title bar. The new Monitor Template has the following default Data 

Windows.  

1. Tree Table Data Window 1-Queue 

2. Tree Table Data Window 2-Users 

3. Line Graph Data Window 1-Active Calls 

4. Line Graph Data Window 2-Queue Calls Inbound 

5. Line Graph Data Window 3–Users Logged In 
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6. Line Graph Data Window 4–Users Available Outbound 

 

 

Figure 4-2 Default Data Windows in New Monitor Template 

Supervisor can add more Data Windows as required. When a new Monitor Template is created, 

the Description area shows its details. 

1. Template Name 

2. Description 

3. Created Date 

4. Modified Date 

5. Last Accessed Date 

 

 

Figure 4-3 New Monitor Template with details 
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4.1.1 Alarms 

For smooth running of the call centre’s affairs, it is vital that the users are alerted when anything 

goes wrong. The users can take effective steps to solve the problem(s). This will enhance the 

productivity of the call centre, and will provide room for improvements. 

 

Suppose, there are many Users sitting idle in one Queue. And in another Queue there are calls 

waiting to be answered just because there are no free Users available. Hence there is a need to 

shift some of the Users from one Queue to the other. The users are alarmed immediately about 

such situations. This is done through the Alarm System in the Supervisor application. 

 

These Alarms can be set in the Data Windows of the Monitor Template(s). The user can set 

different values for different Alarm states for the Data Statistics. Whenever the current value 

exceeds the already set threshold, an Alert Message will inform the users about the state for that 

Data Statistic. The Alert messages pop up in the System Tray. Figure 4.4 shows an Alarm 

message appear in the System Tray, when a threshold value has been crossed.  

 

 

Figure 4-4 Alarm Message pop up 

To get the Alarm messages, the Supervisor application should be active and connected with the 

Arc  CT Server. If a threshold value exceeds while the application is close then messages are 

shown immediately after the user logs in.  

 

4.1.1.1 Alarm States 

The users can declare a value for the Data Statistic that alerts them about the problem. The 

Alarm system has four levels of concern. These are called Alarm States in the Monitor 

Templates. 
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1. Zero State: It is the State when the values are Zero (Null) for the Data Statistics. 

2. Running State: In this state, figures are between the Zero and Caution State for 

Data Statistics. 

3. Caution State: This state is the first warning for the Supervisors. Users can set 

values. 

4. Warning State: Values set here by the users are the second and final warning for 

them. 

 

Alarms conditions are given for the Data Window against a Data Statistic in relation to the 

Data Item. For example, if the user wants to enter Alarm conditions for the Users Available in 

Queue_one in Console Connect, they can be entered in the Data Window. Condition will apply in 

all the Data Windows for this Data Statistic (Available Users) within the Data Item (Queue_one).  

 

4.1.1.2 Setting Thresholds 

To set the Alarm Conditions for any Data Statistic, 

 

1. Open Monitor Template in the Supervisor application. 

2. Open the Data Window in which Alarms are required.  

3. Right click on the Data Item for which the Alarm conditions are required to set in Data 

Window. The Data Item covers a specific area in all the Data Windows. In Bar Graph, it 

shows in different colours. In Tabular Data Windows, Data Items cover a specific block in 

the Table. Line represents Data Item in Line Graph.  

4. Select Set Threshold from the popup menu.  

5. A window will appear with a list of Data Statistics for the selected Data Item.  

6. To enter Alarm conditions for a specific Data Statistic, select it from the list on the left 

side. Only relevant Data Statistics are seen in the list on the left side based on the Data 

Item. 

7. Window will show default colours for each state, which are as under, 

Zero State Background Colour: White  

Zero State Font Colour: Blue 

 

Running State Background Colour: White  

Running State Font Colour: Green 
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Caution State Background Colour: Yellow 

Caution State Font Colour: Black 

 

Warning State Background Colour: Red 

Warning State Font Colour: Black 

 

Alarm State’s background colour is in all types of Data Window, whereas Alarm State’s 

font colour is seen only in the Tabular Data Windows. 

8. Difference among four states is based on the Alarm Threshold values given by the user in 

Caution and Warning Sate. The user should enter an Alarm Threshold value for 

caution state and relatively higher Alarm Threshold value for Warning State. 

9. The users can choose to flash the area for the Data Statistic in the Data Window by 

selecting the option Flash on Caution/Warning. 

10. The users can also give a message that is displayed when the threshold exceeds. Select 

the option Caution/Warning State Message and type the message in the text box. 

11. The users can also play a sound when the threshold exceeds. Select the option Play 

Sound On Caution/Warning and browse for the Wave sound file to be attached with 

the state. Two default wave sound files are provided and can be selected with the 

Configure button and selecting them in Supervisor folder on the hard disk. 
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12. When Thresholds are set, click the Ok button. 

 

 

Figure 4-5 Window for setting Thresholds 

4.1.2 Data Window Types 

There are seven types of Data Windows in a Monitor Template.  

1. Tree Table  

2. Standard Table 

3. Call Table 

4. Bar Graph 

5. Line Graph 

6. Pie Chart 

7. Frames 

They are explained as follows, 
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4.1.2.1 Tree Table Data Window 

Drill down facility is available in this Data Window. This window supports the tree style for 

showing details of the Users in Queue and Queues in a module. 

 

 

Figure 4-6 Tree Table Data Window 

Drill down facility depends on the Data level and Data Item type selected by the user in this Data 

Window. The features for the Tree Table are as follows,  

 

1. User can copy the table in the Monitor Template. 

2. A Call Table can be generated instantly from a Tree Table. 

3. The properties of Tree Table can be edited at any time. 

4. Threshold values can be set on this Table. 

5. It has three Data Levels; System, Module and Queue User. 

6. Data Level and Alarms for the Data Window are shown in the Status Bar.  

7. Number of (Selected/Total) Data Items and Alarms are shown in the Data Window with 

Data Level. Data Levels/Items have different colours in Data Window. 

 

4.1.2.2 Standard Table Data Window  

This Data Window displays information in a standard column and row format.  

 

 

Figure 4-7 Standard Table Data Window 
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Some of the features of the Standard Table are as follows, 

1. User can copy the Standard table in the Monitor Template. 

2. User can edit the table on run time. 

3. Threshold values can be set from this Table. 

4. It has three Data Levels, Queue, User and Queue User. 

5. Data Level for the Data Window and Alarms are shown in the Status Bar. 

 

4.1.2.3 Call Table Data Window 

This Data Window is specifically for the supervision of Calls. The data statistics for this table are 

related to the Call information.  

 

 

 

 

 

 

 

Figure 4-8 Call Table Data Window 

Some of the features of Call Table are as follows, 

 

1. It can be copied in the Monitor Template. 

2. Properties of Call Table can be edited at run time. 

3. This Table can also be generated at run time from any tree table present in the template. 

4. It has four Data Levels: System, Module and Queue User. 

5. If the user selects the Data level as Queue then only Queues can be selected as Data 

Items. If the user selects the Data level as User then only Users can be selected as 

Data Items. In other Data Levels both Data types are available, user can choose Data 

Items for one type only. For example, a user can either select Queues/Sessions or Users 

as Data Items. 

6. Data Level for the Data Window and the number of Data Items selected are shown in the 

Status Bar. 
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4.1.2.4 Bar Graph 

This is a traditional Bar Graph. Data elements are shown on one axis and Data Statistics on the 

other. 

 

Figure 4-9 Bar Graph Data Window 

Some of the features in the Bar Graph type are as follows, 

1. Bar Graph window can be copied in the Monitor Template. 

2. The properties of Bar Graph window can be edited at run time. 

3. It can also be exported as .bmp image. 

4. Bar graph can be printed.  

5. The user can choose the axis for Data Items and for Data Statistics in the Wizard. 

6. Graph refreshes for every 10 seconds. 

7. Threshold values can be set from this graph. 

8. The user can change colours for the Data Window. 

9. The user can change 3D settings of this Data window. 

10. It has three Data Levels: Queue, User and Queue User. 

11. If the user selects Queue Data Level then only the Queues can be selected as Data 

Items. If the user selects the User as Data Level, then only Users can be selected as 

Data Items. Selecting Data Level as Queue User would allow the user to select only one 

Queue or one User as Data Item. 

12. Data Level, the selected Data Items, the page number and Alarms are displayed in the 

Status Bar. 
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4.1.2.5 Line Graph 

This is a traditional Line Graph. Only one of the Data Statistics can be selected from the list.  

 

 

 

 

 

 

 

 

Figure 4-10 Line Graph Data Window 

Some of the features of the Line Graph are as follows, 

 

1. Line Graph window can be copied in the Monitor Template. 

2. Properties of Line Graph window can be edited at run time. 

3. Line graph can also be exported as bmp image. 

4. Line graph can be printed.  

5. The user can change colours for the Data Window. 

6. The user can change 3D settings of this Data Window. 

7. Threshold values can be set from this graph. 

8. Only one Data Statistic may be selected in this Data Window type. 

9. Graph will refresh after every 10 seconds, a new interval is added as a line on the Graph. 

10. Number of intervals on the Graph depends upon the size of the graph in the Monitor 

Template. Number of intervals adjusts automatically.  

11. It has three Data Levels, Queue, User and Queue User. 

12. If the user selects Queue Data Level then only the Queues can be selected as Data 

Items. If the user selects the User as Data Level, then only the Users can be selected as 

Data Items. Selecting Data Level as Queue User would allow the user to select only one 

Queue or only one User as Data Item. 

13. Data Level and Alarms are shown in the Status Bar. 
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4.1.2.6 Pie Chart Data Window 

This is a traditional Pie Chart. Only one of the Data Statistics can be selected from the list.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-11 Pie Chart Data Window 

Some of the features of Pie Chart are as follows, 

 

1. Pie Chart can be copied in the Monitor Template. 

2. Properties of Pie Chart can be edited at run time. Note that the Data Item cannot be 

changed. 

3. Pie Chart can be exported in .bmp format. 

4. Pie Chart can be printed. 

5. The user can change colours for the Pie Chart. 

6. The user can change 3D settings of Pie Chart. 

7. Graph refreshes after every 10 seconds. 

8. It has three Data Levels, Queue, User and Queue User. 

9. If the user selects Queue Data level then only the Queues can be selected as Data 

Items. If the user selects the User as Data Level, then only the Users can be selected as 

Data Items. Selecting Data Level as Queue User allows the user to select only one 

Queue or one User as Data Item. 

10. The Data Level and Alarms are shown in the Status Bar of the Data Window. 
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4.1.2.7 Frames Data Window 

This Data Window is a replica of the System Monitor section. Users and Queue can be selected as 

Data Items.  

 

 

Figure 4-12 Frames Data Window 

1. Frame window can be copied in Template. 

2. Properties of Frame window can be edited at run time. 

3. Threshold values can be set for the Frame window. 

4. The user can change orientation of Picture and Statistics. 

5. There are three Data Levels, Queue, User and Queue User. 

6. Only one Data Item can be selected. If Data Level is Queue User. Multiple Data Items 

may be selected where Data Level is Queue or User. 

7. If the User selects the Data Level as User or Queue User, then the default image can 

be replaced. In Data level Queue, default image representing Queues is shown in the 

Frames. 

8. Data Level and the Alarms are shown in the Status Bar. 

4.1.3 Data Levels 

The data can be viewed at different levels. If Data Level is selected as Queue then there would 

be only 5 calls shown as answered for that User, but if the Data Level is for a Module then there 

would be 10 calls shown as answered for that User. 

<<TOC 

   

    40 



 

It may happen that the User actually has answered more than 10 calls forwarded to his extension 

from Queues/Voice Sessions of other Modules. Data Level ‘System’ would the exact information 

in that case.  

 

Different choices are available for the users in Data Level window based upon the Data Window 

type selected.  

 

 

For example, a User is logged in two Call Queues i.e. Sales and Reception 

and has received 5 calls in Sales Queue, but has also received 5 calls 

delivered in Reception Queue. Monitor Template gives the Supervisor this 

facility for selecting a Data Level to view the exact information at every level.  

 

 

 

 

 

 

 

 

4.1.3.1 System 

If Data Level is selected as System, the information in Data Statistics is shown for all modules. 

For example, the answered calls for a User at System Level will be the addition of all calls 

answered in the entire Users’ allocated Queues and all calls answered outside of these Queues.  

 

4.1.3.2 Module 

Arc Connect is divided into modules for answering calls. These modules are  

• Console Connect 

• Voice Connect 

The Supervisor application can monitor the activity of all these modules through the System 

Monitor. 
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If the information is required at the module level then select Data Level as Module.  

 

For example, if the user wants to see the answered calls of a User within 

Console Connect module then Data Level while creating a Data Window must 

be Module, and that Specific User is to be selected as Data Item. Data 

Statistic should be Answered Calls, than Data Window will give the desired 

information to the user. 

 

 

 

 

 

 

 

4.1.3.3 Queue 

If Data Level is selected as Queue, the information in Data Statistics is shown only for the 

Queues Level. For example, the Data Statistics Answered Calls for an User will show the 

answered calls within the Queue. To see the answered calls in other Queues, the user will add 

the Queues in the Data Items. 

 

4.1.3.4 User 

In this Data Level, the Data Statistics show information for specific Users selected as Data Items. 

This Data Level does not differentiate among the Modules or Queues. Use this Data Level to 

monitor specific Users.  

 

4.1.3.5 Queue User 

This Data Level is about the relation between Queue and User. If the users select Queue User 

as data level and Queue as data item then data is shown for all the Users in the Queue. If the 

users select Queue User as data level and User as data item then data is shown fort all the 

Queues assigned to that User. 

4.1.4 Data Items 

Data Items are the entities for which the user can view the Data Statistics. These Data Items 

may be the Queues/Voice Sessions or the Users. Data Window can have only one Data Item, 

either the Queues/Voice Sessions or the Users. After selecting an item, the user can then select 

the required Queues/Voice Sessions or the Users from the available list.  
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Selection of more than one Data Item is restricted if the user has selected Data Window as Bar 

Graph, Line Graph or Pie Graph and Data Level as Queue Users. The user is allowed to select 

only Queues/Voice Sessions or the Users. In that case if ‘Queue’ were selected as Data Level 

then Data for all Users in Queues/Voice Sessions selected would be shown in the Data Window. 

If User were selected as Data Level then All the Queues for Users selected would be shown in 

the Data Window. 

 

4.1.4.1 Queues 

If the user selects the Data Item Type as Queue, all the Console Connect Queues and Voice 

Connect Voice Sessions populate the Data Item list. The user should select the required Data 

Item from the available list. 

 

4.1.4.2 User 

If the user selects the Data Item Type as User, then all the Console Connect Operators 

populate the Data Item list. The user should select the required Data Item from the available list. 

4.1.5 Data Statistics 

Data Statistics are viewed in the Data Window for the selected Data Item. This information 

can be a  

1. Numeric value i.e. Total Answered Calls.  

2. Time Based Value i.e. Total Logged in Time.  

3. Text Based Value i.e. Device Status.  

 

These values appear in available Data Statistics List when the user selects the required radio 

button in the Data Window Wizard. The user may select a Numeric, Time Based and Text 

Based or All for a Data Window. In the Line Graph, only one Data Statistic is selected. 

 

Set of Data Statistics available in the Data Window may vary depending on the Data Window, 

Data Level, Data Item Type selected, and Data Statistics selected. 

4.1.6 Monitor Template Controls 

The Monitor Template opens in a new window, therefore it has its own Menu Bar and Tool Bar. 
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4.1.6.1 Menu Bar 

The options in the menu bar are described in the following table, 

Control Name Explanation 

File 

Save Template Select to save the template with name displayed in the window’s 

Title Bar i.e. System Monitor Template1. 

Save Template As Select to save the template with the required name. 

 

Rename Template Select to rename an opened template as required. 

 

Set Template 

Description 

Select to enter a description for the Monitor Template. 

 

Exit Select to close the System Monitor Template. 

Data Window 

New  

Data Window Select to create a new data window. 

Arrange Windows  

 Tile Set all the opened Data Windows in Tile format. The options 

available for Tile are, 4 in a row, 3 in a row, 2 in a row, 1 in a 

row or Actual size. 
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 Cascade Set all the opened Data Windows in Cascade format. 

Window: It shows a drop down menu of all the Data Windows open in an active Monitor 

Template. 

Table 4-1 

 

4.1.6.2 Tool Bar 

The Tool Bar displays icons according to the selection of the Data Windows. The description of 

functions for the icons is given in the table. 

 

 

Control Name Icon Explanation 

Save Template 

 

Click to save the template. 

Create a New Data 

Window 

 Click to create a new Data Window other than the ones 

being shown in the Monitor Template. It opens the Data 

Window Wizard. 

Edit Data Window 

Properties 
 

Click to edit the properties of the Data Window already 

opened and selected. 

On selecting the Line Graph, Bar Graph and Pie Chart Data Windows, following icons enable. 

Print Data Window 

Contents 
 

Click to print the selected Data Window. 
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Export Data Window 

Contents 

 

Click to export the contents of the selected Data 

Window. 

Set Data Window 

Colours  

Click to set the colours of the selected Data Window. 

Enable/Disable 3D 

Tunings  

Click to either enable the 3D Tunings or disable them. 

3D Rotation 

 

Click to rotate the graph in the selected Data Window. 

3D Offset 

 

Click to move the graph in the selected Data Window. 

3D Depth 

 

Click to set a depth for the graph in the selected Data 

Window. 

3D Zoom 

 

Click to Zoom in or Zoom out the graph. 

 
Reset To Defaults Click to restore the settings of the graph. 

In addition to the above icons, if Bar Graph Window is selected, the following icons also enable. 

First Page  
 

Click to move to the first page. 
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Previous Page 

 

Click to move to the previous page 

Next Page 
 

Click to move to the next page. 

Last Page 

 

Click to move to the last page. 

Max. Stats/Page 

 

It sets the maximum number of Data Statistics per page 

for the selected Data Window. 

Table 4-2 

 

4.1.7 Creating New Data Window 

When a new Monitor Template is opened, it contains six default Data Windows. If users want to 

add new Data Window in the opened Monitor Template, they can create one in the Data 

Window Wizard. 

1.   

Select Data Window Wizard option in the 

Menu Bar to create a new Data Window. You can 

also click  icon in the tool bar to create a 

new Data Window. 
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2.   

The first window will open with an introduction 

note. Click Next to continue. 

3.   

In the second window, it allows the user to 

select one Data Window from the drop down 

list. 

Select any one of the Data Window you require 

creating. 

Click Next to continue. 

4.  

 

 

 

In the next window, user is prompted to 

select a Data Level from the list. The Data 

Levels display according to the Data 

Window Type selected.  

Click Next to continue. 

5.  

 

 

Select a Data Item in the next step. There are 

two types of Data Items, Queues/Sessions and 

Users. The Data Items enable according to the 

Data Level selected. 

Supervisor can select a radio button if both are 

enabled. Otherwise the default will be selected. 
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6.  

 

 

Then select available items from the list.  

Select Item(s) from the Available list, them click 

on the  to add it in the Selected list.  

Click Next to continue. 

7.  

 

 

In the next window, select Data Statistics. There 

are three types of Data Statistics, Numeric, 

Time Based and All. Supervisor can select any 

one of the radio buttons. 

Then select Item(s) from the Available list and 

click  to add in the Selected list. 

Click Next to continue. 

8.  

 

In the next window, Supervisor is allowed to 

arrange the order of the Data Statistics. Click 

 and  buttons to arrange the order. 

Click Next to continue. 

If the user is creating a graph or Standard table, then the next window after step 8 will be as 

follows, 
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9. In this window, select a radio button to define an 

orientation of the Data Statistics and Data Items. 

The Graph or Standard Table will display in the 

defined orientation. 

By default Data Statistics are selected on Y-axis 

and Data Items on X-axis. 

Click Finish to complete the creating of Data 

Window. 

 

 

If the user is creating a Frame Data Window, then the next windows in steps 10 -11 after step 8 

will be as follows, 

10.  The user is allowed to select an option for 

displaying the picture in the Frame Data 

Window. By default the first radio button is 

selected. 

Click Next to continue. 

11.  In the next window, user can change pictures for 

the Users.  

Select an User from the list, a default image will 

appear. If you require changing it, click the 

Browse button to choose an image from the 

system. 

Click Finish to complete creating a Data Window. 

If the user has selected Users in the Data Items then the window in Number 11 above will 

display. In case of Queues, a default image will appear for all Queues selected. 
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4.1.8 Set Data Window Colours 

The colours used in the Graph Data Windows can be changed for a Monitor Template. They can 

also be set as default for the new Data Windows to be created in other Monitor Templates. The 

user can set colours of the following Data Windows: 

1. Bar Graph 

2. Line Graph 

3. Pie Chart 

To set colours for a Graph Data Window, right click on the Data Window. Select Set Colours 

from the Popup menu. 

Every Graph Data Window has different setting options for colours. 

You can also click on the  icon to Set Colours. 

4.1.8.1 Bar Graph  

 User can set the colours for the following options 

in a Bar Graph Data Window. 

• Background 

• Axis 

• Stat Names (Data Statistics Label) 

• Scale Values (Scale Values along the axis) 

• Grid Lines 
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To change colour, 

1. Click an option, for example Back Ground. 

2. Select colour from the Colour Palette.  

3. Click Ok when done. 

If you want to set the selected colour as default for all the Bar Graphs, click Set 

As Default button.  

Reset button will set all the colours of the Graph according to the default 

colours in the application. 

 

 

 

 

 

 

 

 

 

 

4.1.8.2 Line Graph  

 User can edit the following options’ colours in 

the Line Graph Data Window. 

1. Background 

2. Axis 

3. Time Scale Values 

4. Scale Values along the Axis 

5. Grid Lines (for Data Statistics) 

6. Grid Lines (for Time Intervals) 

7. Title of the Line Graph 
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To change colour, 

1. Click an option, for example Back Ground. 

2. Select colour from the Colour Palette.  

3. Click Ok when done. 

If you want to set the selected colour as default for all the Line Graphs, click 

Set As Default button.  

Reset button will set all the colours of the Graph according to the default 

colours in the application. 

 

 

 

 

 

 

 

 

 

4.1.8.3 Pie Chart  

 

User can edit the following options’ colours in a 

Pie Chart Data Window. 

• Background  

• Title of the Line Graph 

 

4.1.9 Closing the Data Window 

To close a Data Window in a Monitor Template, 

1. Right click on the Data Window. 

2. Select Close from the popup menu. 

3. The Data Window will disappear from the Monitor Template. 
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If the user saves the changes after closing the Data Window and closes the Monitor Template, 

then the Data Window is deleted permanently from the Monitor Template. If changes are not 

saved and Monitor Template is closed, then Data Window will be there on opening the Monitor 

Template. 

4.1.10 Copying the Data Window 

A Data Window can be copied in the same opened Monitor Template. The new Data Window will 

have same properties as the original Data Window. The new Data Window will have a separate 

Identity and its properties can be edited without disturbing the Data Window. This is useful when 

user wants the new Data Window perform different from the original one. In this case instead of 

repeating steps of Data Window Wizard, the user can copy the Data Window and then change its 

Properties according to the requirements. 

 

To copy the Data Window in the Monitor Template, 

1. Right click on the Data Window. 

2. Select Make Copy from the popup menu. 

3. A new Data Window is copied in the Monitor Template with same properties. 
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4.2 Arc Connect Reports 

The users can use this function to produce Text reports, based on the Historical Data. 

Arc Connect > Reports > Overview displays the fields shown in figure 4.13. 

Once the criteria have been selected, click the Run Report icon .  

 

 

Run Report

Figure 4-13 Click Run Report icon to create a report 
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To run report, 

1. Select the required report from the Description Area. 

2. Select the relevant Date, Time, and other setting criteria for the report. 

3. Every report has different setting criteria. 

4. Click icon  to run report. 

A sample report generated is as follows, 

 

 

Figure 4-14 Sample Text Report 

 

The Report Window contains a Tool Bar with the following icons, 
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4.2.1 Tool Bar 

The icons in the tool bar are described as follows, 

Control Name Icons Explanation 

Print Report  Click to print the report. 

Export Report  Click to export the report in formats, 

• Excel (.xls) 

• Cascading Style Sheet (.css) 

• HTML (.html, .htm) 

• Adobe Acrobat Reader (.pdf) 

• Word (.rtf) 

 

Size 

 

The Report page can be resized as required. The 

options are, 

• Whole Page 

• Page Width 

• 100% 

Scroll Arrows  These arrows allow the users to move in the report if it 

is more than one page. 

Percentage 

Selection 
 

The user can manually enter the required size for the 

report.  

Table 4-3 

4.3 Arc Connect Online Updates 

The application provides the ability to make instant operational changes. Within Arc Connect, a 

user can make On-line Updates in the following categories, 

1. Directory Configuration 

2. Main Directory Numbers 

3. Directory Groups 

4. CLI Numbers 
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5. DDI Numbers 

6. External CLI Details 

7. Directory Settings 

8. Users 

9. Reasons Codes 

10. Messaging 

11. Personal Call Park Location 

12. Presence Management 

4.3.1 Directory Configuration 

It provides the functionality of On-line Updating for Directory Configuration. The user can add or 

modify the Job Titles, Regions, Branches and Departments. There are four sub-sections for 

Directory Configuration, 

1. Manage General Setting 

2. Manage Regions 

3. Manage Branches 

4. Manage Departments 

 

4.3.1.1 Manage General Settings 

The window allows the users to the job titles for the workers. Select Arc Connect > On-line 

updates > Directory Configuration > Manage General Setting, 

 

Figure 4-15: Manage General Settings (Job Titles) 
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To add a Job Title 

1. Click New to add a new Job Title. 

2. Enter Full Job Title. 

3. Enter Job Title. 

4. Click Update. 

5. Click Exit. 

 

To delete a Job Title 

1. Select a Job Title from the list. 

2. Click Delete. 

3. Click Exit. 

 

To update Job Title  

1. Select a Job Title from the list to update. 

2. Update/Change details of the Job Title. 

3. Click Update. 

4. Click Exit. 

 

4.3.1.2 Manage Regions 

This window allows the users to set filters for regions. Also users can enter region details. Select 

Arc Connect > On-line updates > Directory Configuration > Manage Regions, 

 

 

Figure 4-16 Manage Regions 
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To add a new Region 

1. Click New to add a new Region. 

2. Enter Name. 

3. Click Update. 

4. Click Exit. 

 

To delete a Region 

1. Select the name of the Region. 

2. Click Delete. 

3. Click Exit. 

 

To Update Region  

1. Select a Region from the list to update. 

2. Update/Change details of the Region. 

3. Click Update. 

4. Click Exit. 
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4.3.1.3 Manage Branches 

The user can set filters for the branches and the region in which they reside. Also the user can 

enter details for the branch. Select Arc Connect > On-line updates > Directory Configuration > 

Manage Branches, 

 

 

Figure 4-17: Manage Branches 

To add a new Branch 

1. Click New to add a Branch. 

2. Enter Name and Code for the new Branch. 

3. Select a Region for this Branch. 

4. Select Queues for this Branch and click Add button. 

5. Click Update. 

6. Click Exit. 

 

To delete a Branch 

1. Select a Branch. 

2. Click Delete. 

3. Click Exit. 
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To Update Branch  

1. Select a Branch from the list to update. 

2. Update/Change details of the Branch. 

3. Click Update. 

4. Click Exit. 

4.3.1.4 Manage Departments 

In this window, the users can set filter for the departments. The users can also enter details for 

the departments. They can set priority for the departments according to the selected branches. 

Select Arc Connect > On-line updates > Directory Configuration > Manage Departments, 

 

 

Figure 4-18: Manage Departments 

To add a new Department 

1. Click New to add a Department. 

2. Enter Name for the Department. 

3. Enter Notes and URL.  

4. Select Region. 

5. Select Branch. 

6. Click Update. 

7. Click Exit. 
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To delete a Department 

1. Select a Department. 

2. Click Delete. 

3. Click Exit. 

 

To update Department  

1. Select a Department from the list to update. 

2. Update/Change details of the Department. 

3. Click Update. 

4.  Click Exit. 

4.3.2 Manage Main Directory Numbers 

The Main Directory Numbers provides the function of On-line Update for them. The user can add 

or modify Main Directory Numbers. Select Arc Connect > On-line updates > Main Directory 

Numbers > Manage Main Directory Numbers, 

 

Figure 4-19: Manage Main Directory Numbers 
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To add a New Main Directory Numbers 

1. Click the New button. 

2. A new window will open for the details of the main directory number. 

 

 

Figure 4-20: Main Directory Device details 

3. Give the General Information about the device. Alternates can be added for First 

Name and Last Name field. It also includes Email, Address and Postal Code. 

4. Select a Contact Category. The contact is used in Internal Directory.  

5. Fill in the Numbers for the contact. All the phone numbers associated with the contact 

can be added here in this area. Alternates can be added for Extension number. 

6. In the Company Information, give information about the Company. 

7. Select an Icon to indicate the contact. While using Web Directory module in Arc Connect, 

every contact can have any special set of icons. Customized icons are grouped as a set in 

Directory Configuration tab. 

8. Add keyword(s) used to search the record in the list of the Main Directory. Console 

Operator application has the use of the keywords while searching for contacts. 

9. The user can also add Contact Notes (for additional contact information) and Absent 

Message (to provide absence reason for the contact) by clicking the Contact Notes 

button. 
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10. Click Update. 

11. Click Close to go to the previous screen. 

12. Click Exit. 

 

Users will only be able to modify/delete the contact fields that have NOT been

mapped for LDAP Synchronization. 

 

 

 

 

To delete Main Directory Numbers 

1. Select a number from the Main Directory Numbers list. 

2. Click Delete. 

3. Click Update. 

4. Click Exit. 

 

To update Main Directory Number  

1. Select a Main Directory Number from the list to update. 

2. Click on Properties. 

3. A new window will open with the details of Main Directory Number. 

4. Update/Change details of the Main Directory Number. 

5. Click Update. 

6. Click Close. 

7. Click Exit. 

 

To edit presence status of a contact, 

1. Select a number from the Main Directory Numbers list and double click. 

2. On the Contact Properties page, Click Status. 

Directory Numbers can only be updated or modified once all the contacts 

have been downloaded from the CT Server. To ensure the download is 

complete, you have to view the Status Bar. 
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3. Edit details for presence status. 

4. Click Update to save changes. 

 

When the contacts are being downloaded from CT Server, the status will be displayed to the user 

in the status bar as shown below: 

 

 

Figure 21 Status Bar Message 
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During the time of download, if the user attempts to access the Directory Numbers or Directory 

Groups, the following message box appears, reminding the user of the current download status. 

 

 

Figure 22 Message Box Displaying that Information is still Being Downloaded 

4.3.3 Manage Directory Group Details 

User can create directory groups and assign devices to them. The users can also select devices 

for the Busy Lamp Field. To modify or add Directory Groups, select Arc Connect > On-line 

updates > Directory Groups > Manage Directory Groups, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-23 Manage Directory Group Details 
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To add a New Directory Groups, 

1. Click New to create a Directory Group. 

2. Enter text in the Name textbox. 

3. Enter a Description. 

4. Add Devices for the new group. 

5. Click Update. 

6. Click Exit. 

 

To delete Directory Group(s), 

1. Select a Directory Group from the list. 

2. Click Delete. 

3. Click Update. 

4. Click Exit. 

 

To update Directory Group(s), 

1. Select a group from the Directory Group list. 

2. Update/Change the details for that group. Add/Remove devices. Change the BLF status 

for the devices included in the group. 

3. Click Update. 

4. Click Exit. 

 

 

 

Directory Groups can only be updated or modified once all the contacts have

been downloaded from the CT Server. To ensure the download is complete, 

you have to view the Status Bar. This is case is similar to that of accessing 

Directory Numbers. 
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4.3.4 Manage CLI Numbers 

CLI Numbers provide the function of on-line update for the CLI numbers. The users can add or 

modify the CLI numbers. Select Arc Connect > On-line updates > CLI Numbers > Manage CLI 

Numbers, 

 

 

 

 

 

 

 

 

Figure 4-24 Manage CLI Numbers 

The users can set properties for the CLI Tags by entering the number and Reference Data. 

Also the user can search for the CLI Tags already entered in the list. 

 

To add a New CLI Number, 

1. Click New. 

2. Enter a number in the Number text box. 

3. Enter a Tag and Reference Data. 

4. Click Update. 

5. Click Exit. 

 

To delete CLI Number(s), 

1. Select a number from the CLI Numbers list. 

2. Click Delete. 

3. Click Update. 

4. Click Exit. 
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4.3.5 Manage DDI Numbers 

It provides the function of on-line update for the DDI Numbers. The users can add or modify DDI 

Numbers. Select Arc Connect > On-line updates > DDI Numbers > Manage DDI Numbers, 

 

 

 

 

 

 

 

 

Figure 4-25 Manage DDI Numbers 

The users can set properties for the DDI Tags by entering the number and Reference Data. 

Also the user can search for the DDI Tags already entered in the list. 

 

To add a New DDI Number, 

1. Click New. 

2. Enter a number in the Number textbox. 

3. Enter a Tag. 

4. Click Update. 

5. Click Exit. 

 

To delete DDI Number(s), 

1. Select a number from the DDI Numbers list. 

2. Click Delete. 

3. Click Update. 

4. Click Exit. 
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4.3.6 Manage Directory Settings 

This tab contains all of the fields for the Contact Details in the list box Available Keywords. 

The user selects the desired keywords from this list box and adds them to the Keyword Search 

Field list box. These selected keywords will then become the filter criteria in the Keywords text 

field for the Main Directory device list page. 

 

Select Arc Connect > On-line updates > CLI Numbers > Manage Directory Settings, 

 

 

                      Figure 4-26: Manage Directory Settings 

4.3.7 External CLI Details 

Users will only be able to modify/delete the contact fields that have NOT been

mapped for LDAP Synchronization. 

 

It provides the function of online update for the External CLI Details. The users can add or 

amend External CLI Details. 
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Select Arc Connect > On-line updates > External CLI Details > Manage External CLI Details, 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-27 Manage External CLI 

 

To add a New External CLI, 

1. Click New to create an External CLI. 

2. Enter details for the new contact in the text boxes required. 

3. Click Update. 

4. Click Exit. 

 

To delete External CLI (s), 

1. Select an External CLI from the list. 

2. Click Delete. 

3. Click Update. 

4. Press Exit. 

4.3.8 Users 

It provides the functionality of online updating for the users. The users can add or modify the 

Users. There are three sections for Users, 

1. Manage Operator Details 

2. Manage Wallboard Details 
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3. Manage Supervisor Details 

 

4.3.8.1 Manage Operator Details 

The users can set Properties for the Users, their Type, and Options. Select Arc Connect > On-

line updates > Users > Manage User Details, 

 

Figure 4-28 Operator Details 

To add a New Operator 

1. Click New to add a new Operator. 

2. Enter Name. 

3. Enter Login Name and Password. Confirm the Password. 

4. Select a Operator Type. 

5. Select options in the Operator Options, Operator Security Options and Call 

Processing 

6. Select the Device Type that the operator will log on to. The supervisor can select 

between three options, Headset, Handset and User Preference. 

a) Headset: If this option is checked then the user will be logged onto the headset. 
 

b) Handset: If this option is checked, user can only logon to the handset. 
 

c) User Preferences: If this option is checked, than user will be able to logon on any of 
the device type. This option will be checked by default. 
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If the user selects any device option, then the user can only logon using that particular option. 

Otherwise an error will be returned by the CT Server. 

 

7. Click Update. 

8. Click Exit. 

 

To update an Operator’s details 

1. Select an Operator from the list. 

2. Details of the selected details will be shown in the window. 

3. Update/change the details as required. 

4. Click Update. 

5. Click Exit. 

 

To delete an Operator 

1. Select an Operator from the list. 

2. Click Delete. 

3. Click Exit. 

 

4.3.8.2 Manage Wallboard Details 

It allows the user to set Properties for the Wallboard Users and assign Modules to them. 

Select Arc Connect > On-line updates > Users > Manage Wallboard Details, 

 

Figure 4-29 Wallboard Details 

<<TOC 

   

    74 



 

To add a new Wallboard 

1. Click New to add a new Wallboard. 

2. Enter Name. 

3. Enter the Login Name and Password. Confirm the Password. 

4. Select modules for the new Wallboard. 

5. Click Update. 

6. Click Exit. 

 

To update Wallboard’s details 

1. Select Wallboard from the list. 

2. Details of the selected details will be shown in the window. 

3. Update/change the details as required. 

4. Click Update. 

5. Click Exit. 

 

To delete a Wallboard 

1. Select the name of the Wallboard. 

2. Click Delete. 

3. Click Exit. 

<<TOC 

Arc Connect Supervisor User Guide 

Version 4.1   75 



 

4.3.8.3 Manage Supervisor Details 

This window allows the user to set Properties for the Supervisors and assign them Modules. 

Select Arc Connect > On-line updates > Users > Manage Supervisor Details, 

 

 

 

 

 

 

 

 

 

 

Figure 4-30 Supervisor Details 

 

To add a new Supervisor 

1. Click New to add a Supervisor. 

2. Enter Name. 

3. Enter Login Name and Password. Confirm Password. 

4. Select Modules Available. 

5. Click Update. 

6. Click Exit. 

 

To update Supervisor’s details 

1. Select Supervisor from the list. 

2. Details of the selected details will be shown in the window. 

3. Update/change the details as required. 

4. Click Update. 

5. Click Exit. 
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To delete a Supervisor 

1. Select a Supervisor. 

2. Click Delete. 

3. Click Exit. 

4.3.9 Reason Codes 

It provides the functionality of online updating for the Reason Codes. The users can add or 

modify them. There are two sections for Reason Codes, 

1. Manage Break Periods Reason 

 

4.3.9.1 Break Periods Reason 

In this window the users can add break reasons for the long periods, the User and Operators will 

be unavailable. Select Arc Connect > On-line updates > Reason Codes > Manage Break Periods

Reason, 

 

 

 

 

 

 

 

 

Figure 4-31 Break Periods Reason 

To add a new Break Reason, 

1. Click New to add a new Break Reason. 

2. Enter Code. 

3. Enter the Description. 

4. Click Update. 

5. Click Exit. 
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To delete a Break Reason, 

1. Select a Break Reason. 

2. Click Delete. 

3. Click Exit. 

 

To update a Break Reason, 

1. Select Break Reason from the list. 

2. Change the Code or Description as desired. 

3. Click Update. 

4. Click Exit. 

 

4.3.10 Messaging 

This section in the Arc Connect Online updates allows the Supervisor to configure the settings for 

Paged messages. The supervisor can make online changes for the messaging functionality 

through this tab. The Messaging section consists of the following four tabs: 

1. Page Request 

2. Page Response 

3. Page Groups 

4. Page Group Contacts 
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4.3.10.1 Page Request 

This sub-tab allows the Supervisor to create, update or delete groups of messages. Each page 

group can contain page requests or messages of similar type. 

 

 

Figure 4-32: Page Request 

 

To create a page request group, 

1. Click the New button. 

2. In Page Request Details section, enter display name and description. This name is 

displayed in Operator’s paging window. 

3. Select Automatically Expand checkbox. If selected, the group list is expanded in 

Operator’s paging window and displays all messages in the group. In this checkbox is 

not selected, only page group are displayed to the Operator however, the Operator can 

manually expand the group to view page requests or messages. 

4. Press Update to finish. The newly created page group will be displayed in the Page 

Requests list. 
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5. The order of page request groups in the list can be changes using the Up and Down 

buttons. Press Update button after changing the order.  

Once a page request group is created, the Supervisor can associate messages to each page 

request group. 

 

To add page request item to a page group, 

1. In the Page Requests list, select the group to which you want to add a message. 

2. In the Request Details section, type the name and text of the page request. The 

name and text typed here are displayed on recipient’s IP Phone screen. 

3. Set priority level. A greater number represents lower priority level. 

4. Select Allow Free Format Message checkbox. This will enable the operator to add 

additional message to the page request. 

5. Click Add to finish. The newly created message will be shown in Page Request Items 

list. 

 

To amend page request item details, 

1. In the Page Request Items list, select the message you want to amend. 

2. Make changes and press Replace button. 

 

To change page request order, 

1. Select the page group for which you want to change the message order. 

2. The messages added to the group will appear in the Requests Items list. 

3. Use  and  to change order. 

4. Press Update to finish. 

 

To delete a page group, 

1. In the Page Requests list, select the page group you want to delete. 

2. Press Delete. 

 

To amend a page group, 

1. In the Page Requests list, select the group you want to amend. 

2. Make changes to the group 

3. Click Update to save changes. 
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4.3.10.2 Page Response 

This tab allows the Supervisor to manage Page Replies. These replies are sent in response to 

page requests through an IP phone. Page replies can be created, updated and deleted in this 

section.  

 

 

Figure 4-33: Page Response 

To create a reply, 

1. Click New button. 

2. Enter display name and message text. 

3. Press Update to finish. The newly created reply appears in the Page Response list. 

 

To amend a reply, 

1. In the Page Response list, select the reply you want to amend. 

2. Amend details and press Update to save changes. 

 

To delete a reply, 

1. In the Page Response list, select the reply you want to delete. 

2. Press Delete. 

<<TOC 

Arc Connect Supervisor User Guide 

Version 4.1   81 



4.3.10.3 Page Groups 

The Supervisor can create a page groups in this sub-tab. A Page group is a set of contacts or 

page recipients.  

 

 

Figure 4-34 Page Response 

 

To create a page group, 

1. Press New button.- 

2. Enter the name and description of the group. 

3. Select a Region from the list. 

4. Press Update to finish. The newly created page group will appear in the Page Group 

list. 

 

To amend a page group, 

1. In the Page Group list, select the group you want to amend. 

2. Change details as required. 

3. Press Update to save changes. 

 

To delete a page group, 

1. In the Page Group list, select the page group you want to delete. 

2. Press Delete 
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4.3.10.4 Page Group Contacts 

The Supervisor can associate a contact with a page group with this tab. The Supervisor can also 

associate one more contacts to a group. Similarly, contact associations can be created or 

removed here. 

 

To associate a contact to a group, 

1. In the Page Group list, select a group. 

2. Press Add button. This will open a new window. 

3. In the new window, select the contact you want to associate with the selected group. 

The supervisor can also search a contact from the directory using different search 

criteria in this window. Only console contacts can be associated to a group. 

4. Press Add. The contact will be added to the selected group and displayed in the 

Contacts Used in Page Group section. 

5. Press Update to finish. 

 

 

Figure 4-35 Page Group Contacts 

 

To remove a contact from group, 

1. In the Page Group list, select the group from which you want to remove a contact. 

2. All contact associated with the group will appear in the contacts list. 

3. Select the required contact and press Remove. The Remove All button removes all 

contacts from the selected group. 
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4.3.11 Personal Call Park Location 

This section in the Arc Connect Online updates allows the Supervisor to configure the settings for 

Personal Call Park. The supervisor can make online changes for the call park locations through 

this tab. The Personal Call Park Location section consists of the following two tabs: 

 

1. Local Call Parking 

2. Remote Call Parking 

 

4.3.11.1 Local Call Parking 

When the currently logged in user parks a call, it is parked at local location. The following fields 

are configured for such locations: 

 

1. Local: This is the extension number assigned to the Pre CT Gateway that holds the 

local parked calls. 

2. Resource Group: This is an optional field where you can specify a resource group for 

local call parking. 

 

 

Figure 4-36 Local Call Park Location 

 

4.3.11.2 Remote Call Parking 

Remote call park location is the one from where a user can access calls parked by other users. 

The following fields are configured for such locations: 
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1. Remote: This is the extension number assigned to the Pre CT Gateway that holds the 

remote parked calls. 

2. Resource Group: This is an optional field where you can specify a resource group for 

remote call parking. 

 

 

Figure 4-37 Remote Call Park Location 

 

4.3.12 Presence Management 

Presence Status is the current status of an internal contact. Each contact can set a presence 

status that can be viewed in the Console Operator’s Internal Directory and Busy Lamp Fields, 

thus letting the operator know whether the contact is ready to take calls or not. The 

Administrator can create new status and configure the attributes as well. 

 

The supervisor can manage the Presence Status as follows, 

1. Select Arc Connect → Online Updates → Presence Management. 
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2. Click on Presence Status and the following form will appear, 

 

 

 

3. Enter the name to be specified in the Status field. 

4. Select the additional attributes (Expiry Date, Expiry Time, Alternate Number and Free 

Format Text) that must be specified by the person when changing status. 
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Section 5: Console Connect 

The fifth folder in the Folder List will be Console Connect. The Console Connect folder 

consists of four segments, 

1. Monitor Templates 

2. Graphical Analysis 

3. Reports 

4. Online Updates 

Console Connect provides information about the Operators’ activities. The Supervisor can view 

the Graphical reports as well as the Text-based ones. The Supervisor is also allowed to make 

online updates instantly.  

 

5.1 Console Connect Monitor Templates 

The Monitor Templates created follow the same steps as described in the previous sections. The 

Monitor Templates created in Console Connect are slightly different from the Monitor Templates 

of Arc Connect in the sense of Data Items.  

 

Difference between Arc Connect and Console Connect Monitor Templates 

 

The Data Items included all the Users and Queues in all the Arc Connect. In the Console 

Connect, the Data Items include only the Console Queues and Operators who can receive the 

Console Queue Calls. 

5.2 Console Connect Graphical Analysis 

The Supervisor can have Graphical Analysed reports based on the historical data. The Graphical 

Analysed information in Console Connect includes on the following segments, 

1. Queue 

2. Operator 

3. Overflow 
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To run any of these reports, select the  to open the required segment as,  

• Console Connect > Graphical Analysis > Queue 

• Console Connect > Graphical Analysis > Operator 

• Console Connect > Graphical Analysis > Overflow 

Once the criteria have been selected, click the Run Report icon .  

 

 

Figure 5-1 Run Report 

To run a report, 

1. Select the required report from the Description Area. 

2. Select the relevant Date, Time, and other setting criteria for the report. 

3. Every report has different setting criteria. 
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4. Run Report. 

A sample graphical analysed report generated is as follows, 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-2 A sample of Graphical Analysis Report 

5.2.1 Tool Bar 

The Graphical Analyses report contains a Tool Bar with the following icons, 

 

Control Name Icons Explanation 

Print 
 

Click to print the graph report. 

Copy to Clipboard 
 

Click to copy the graph report. Then manually paste 

the graph in a file. The graph report can be pasted in  

• Word 

• Paint 

Size 
 

The Report page can be resized as required. The 

options are, 

• Whole Page 

• Page Width 

• 100% 
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Scroll Arrows  These arrows allow Supervisor to move in the graph 

report if it is more than one page. 

Percentage 

Selection 

 Supervisor can manually enter the required size for the 

graph report.  

Max. Points per 

Page 

 This is the number of intervals in the graph. 

Normal 
 

This icon is clicked by default.  

You can click it to view the graph in normal mode. 

Rotate 
 

Click to rotate the graph along the axis.  

You will have to place the cursor on the graph and 

rotate it. 

Move 
 

Click to move the graph in required direction(s). 

Move the graph with your cursor. 

Zoom 
 

Click to zoom the graph. 

Depth 
 

Click to increase or decrease the depth of the graph. 

Drag your cursor inwards and outwards for the 

required depth. 

Table 5-1 

5.3 Console Connect Reports 

The Reports in Console Connect also generate in the same approach as described and explained 

in the Arc Connect Reports. The Report information in Console Connect includes on the following 

segments, 

1. Over View 

2. Queue 

3. Operator 

 

To run any of these reports, select the  to open the required segment as,  

• Console Connect > Reports > Over View 

• Console Connect > Reports > Queue 

• Console Connect > Reports > Operator 
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Difference between Arc Connect Reports and Console Connect Reports 

The Arc Connect Reports involve all the activities information that take place. It shows the 

reports including data for all the modules in Arc Connect. 

 

In Console Connect, the reports will include information about the Operators and Queues. The 

reports will display the information about the calls specific to the Operators and Queues.  

 

Once the criteria have been selected, click the Run Report icon . This can be chosen from 

the icon field at the top of the Arc Supervisor application or as shown above. 

 

 

 

Run Report 

Figure 5-3 Click Run Report icon to create a report 
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To run a report, 

2. Select the relevant Date, Time, and other setting criteria for the report. 

3. Every report has different setting criteria. 

1. Select the required report from the Description Area. 

4. Run Report. 

A sample report generated is as follows, 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-4 Sample Report for Console Connect 

5.3.1 Tool Bar 

Control Name Icons 

 

 

Explanation 

Print Report  Click to print the report. 

Export Report 
 

Click to export the report in formats, 

• Excel (.xls) 

• Cascading Style Sheet (.css) 

• HTML (.html, .htm) 

• Adobe Acrobat Reader (.pdf) 

• Word (.rtf) 
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Size 
 

The Report page can be resized as required. The 

options are, 

• Whole Page 

• Page Width 

• 100% 

Scroll Arrows  These arrows allow Supervisor to move in the report if 

it is more than one page. 

Percentage 

Selection 

 The user can manually enter the required size for the 

report.  

5.4 Console Connect Online Updates 

Within the Console Connect, the Supervisor can make On-line Updates in the following segments, 

1. Operator Control 

2. Operator Details 

3. Queue Control 

4. Queue Details 

5. Call Filters 

6. Break Hours 

5.4.1  Operator Control  

The Operator Control provides the On-line Update function to logout an Operator. It has one 

option, 

1. Log Out an Operator 
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5.4.1.1 Log Out an Operator 

This is used to log-out an Operator or all Operators. Select Console Connect > On-line updates > 

Operator Control > Log Out An Operator 

The following window will appear, 

 

 

 

 

 

 

 

 

 

Figure 5-5Operator Logout 

To logout an Operator, 

1. Select the Operator from the Logged In Operators list. The names of the Queues that 

the Operator is currently logged-in to will be shown.  

2. Click Log Out if Logging-out one Operator. If logging out all Operators, there is no need 

to select Operator names as in step 1. Simply click Log Out All. 

3. Click Exit. 

After any On-line Update, an information window will be shown, 

 

 

Figure 5-6 Message for logout 

This window confirms that the changes have been made. Click Ok. 
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5.4.2 Operator Details  

The Operator Details function provides the following on-line update possibilities. 

1. Manage Operator Queues 

2. Manage Operator Groups 

 

5.4.2.1 Manage Operator Queues 

The Supervisor can change the Operator’s Queues in the following ways: 

Select Console Connect > On-line updates > Operator Details > Manage Operator Queues, 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-7 Manage Operator Queues 

Manage Operator Queues, 

1. Click on the name of the Operator from the Operator Name list. This will automatically 

display the Operator’s Queues. 

2. Select from the Available Queues list. 

3. Click Add. 

4. To remove a Queue from Operator, Select a Queue and click Remove. 

5. Click Update. 

6. Click Exit. 
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5.4.2.2 Manage Operator Groups 

The Supervisor can change and manage the Operator’s Groups. 

Select Console Connect > On-line updates > Operator Details > Manage Operator Groups, 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-8Manage Operator Groups 

Manage Operator groups, 

1. Select the Operator from the Operator Name list. This will automatically display the 

Operator’s Groups. 

2. Select from the Available Groups list. 

3. Click Add. 

4. To remove a Group from Operator, Select a Group and click Remove. 

5. Click Update. 

6. Click Exit. 

 

5.4.3 Queue Control 

The Queue Control provides the following on-line update functions, 

1. Take a Queue Out of Service. 

2. Put a Queue in Service. 
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5.4.3.1 Take a Queue Out of Service 

This function allows the Supervisor to take an existing Queue out of service. 

Select Console Connect > On-line updates > Queue Control > Take a Queue Out of Service, 

 

 

 

 

 

 

 

 

Figure 5-9 Take a Queue out of Service 

To take a Queue out of service, 

1. Select the Queue from the list. 

2. Set the Redirection type if there is none set before. 

3. Click the De-Activate button. 

4. To de-Activate all the Queues, click the De-Activate All button. 

5. Click Ok on the message screen. 

6. Click Exit. 
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5.4.3.2 Put a Queue in Service 

This function allows the Supervisor to put an existing Queue in service.  

Select Console Connect > On-line updates > Queue Control > Put a Queue in Service, 

 

 

 

 

 

 

 

 

Figure 5-10 Put a Console Queue in Service 

To put a Queue in service, 

1. Select the Queue from the list. 

2. Click the Activate button. 

3. To activate all the Queues, click the Activate All button. 

4. Click Ok on the message screen. 

5. Click Exit. 

 

5.4.3.3 Put Queue in Emergency Mode 

This feature allows the users to put the Console Queues in Emergency mode. The Supervisor can 

select any queues from here and put them into the emergency mode. The supervisor application 

requests the CT Server to declare emergency for the selected Queue(s). The CT Server then 

notifies all the connected User applications about the emergency status of these queues, the 

Applications will change the status of these queues to denote their Emergency status. 

 

Figure 5-14 put a Queue in Emergency mode 
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To put a Queue in emergency 

1. Select the Queue from the list. 

2. Click the De-Activate button to put the selected queues into Emergency mode. 

3. To put all the Queues in Emergency mode, press the De-Activate All button.  

4. Click Ok on the message screen. 

5. Click Exit. 

 

5.4.3.4 Take Queue out of Emergency mode 

This feature allows the Supervisor to take the Console Queues out of Emergency mode. The 

Supervisor requests the CT Server to take the selected queues out of the Emergency mode and 

put them into Service. The CT Server in turn notifies all the connected applications to take out 

the selected queues out of the Emergency Mode. 

 

Figure 5-15 Take a Queue out of Emergency mode 

To take a Queue out of Emergency mode, 

1. Select the Queue from the list. 

2. Click the Activate button to take out the selected Queue from the Emergency mode. 

3. To put all the Queues out of the Emergency mode, click the Activate All button. 

4. Click Ok on the message screen. 

5. Click Exit. 

5.4.4 Queue Details  

The Queue Details function provides the following on-line update to Manage Console Queue 

Details. It has one segment, 

1. Manage Queue Details 
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5.4.4.1 Manage Queue Details 

To change the details of an existing Queue, Select Console Connect > On-line updates > Queue 

Details > Manage Queue Details, 

 

 

Figure 5-11 Manage Queue Details 

To add Queue Details, 

1. Enter Name and Location. 

2. Select an Automatic Distribution, Longest Wait or Circular. 

3. Select Overflow Properties. 

4. Select an option from the Forward Destination Type. 

5. Select an option from the Forward Destination. 

6. Enter value for the Overflow Data. 

7. Click Update. 

 

To change Queue Details, 

1. Click on the name of the Queue from the Queue Name list. This will automatically 

display the Queue properties. 

2. Change the Queue properties as required. 

3. Click Update. 

4. Click Exit. 
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5.4.5 Call Filters 

The Call Filters section provides the function to update for the Call Filters and the Routing Tag 

Groups online.  

 

5.4.5.1 Manage Call Filters 

The Supervisor can use Mange call filters to route incoming calls to their intended destination. 

 

To Create a New Call Filter, Select Console Connect > On-line updates > Call Filters > Manage 

Call Filters, 

 

 

Figure 5-12 Manage Console Call Filters 

To add a Call Filter, 

1. Select the Queue from the Queue Name list.  

2. Select the type of filter from the Available Filters list. 

3. Click New. 

4. Select the relevant Resource Group from the drop down box. 

5. Enter the number in the Number text box. 

6. Enter the required text in the Routing Tag text box. Ensure that all required Operator 

applications have the routing tag enabled in their call information to display this text. 

7. Click Update. 
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8. Click Exit. 

 

 

Multiple filters can apply to a single Queue, i.e. there may be multiple 

numbers sent to a single Queue. 

 

 

 

 

 

To delete a Call Filter, 

1. Click on the name of the Queue from the Queue Name list.  

2. Select the filter to be removed. 

3. Click Delete. 

4. Click Exit. 

 

Types of Filter 

There are nine filters assigned to a Queue. 

 

1. CLI exact match filter: Any calls with this exact CLI will be sent to the required 

Queue. 

2. CLI pattern match filter: Any calls matching this CLI pattern will be filtered to the 

required Queue. For example, all calls that are CLI begin with 02084* will be filtered to 

the required Queue. 

3. DDI exact match filter: Any calls matching this DDI will be filtered to the required 

Queue. 

4. DDI pattern match filter: Any calls matching this DDI pattern will be filtered to the 

required Queue. All calls that’s DDI begins with 100* will be filtered to the required 

Queue. 

5. Divert exact match filter: All calls that have been diverted from a device to any Pre 

CT Gateway, will arrive in the Queue in which this filter is applied. 

6. Divert external call filter: All External calls that have been diverted from a device to 

any Pre CT Gateway and could not be caught by any divert filter will arrive in the Queue 

in which this filter is applied. User does not need to give any number in case of this filter. 

This filter will be applied only once in any call queue in the system. 
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7. Divert internal call filter: All internal calls that have been diverted from a device to 

any Pre CT Gateway and could not be caught by any divert filter will arrive in the Queue 

in which this filter is applied. User does not need to give any number in case of this filter. 

This filter will be applied only once in any call queue in the system. 

8. Divert pattern match filter: All calls that have been diverted from a device (with a 

number that matches the pattern given in this filter) to any Pre CT Gateway, will arrive in 

the Queue in which this filter is applied. If user has given a number i.e. 300 in this filter 

then all calls from 3005 and 3006 diverted to a Pre CT Gateway will arrive in this Queue. 

9. No call Divert match filter: All calls that have been diverted from a device to any Pre 

CT Gateway and could not be caught by any divert filter will arrive in the Queue in which 

this filter is applied. User does not need to give any number in case of this filter. This 

filter will be applied only once in any call Queue in the system. This filter will work in the 

absence of Divert internal call filter and Divert external call filter. 

 

5.4.5.2 Manage Routing Tag Groups 

This provides the function of on-line update for the Routing Tag Groups for the Console 

Connect Queues and the filters for Queues. Supervisor can add or remove Routing Tag Groups 

for the Queues and the filters for Queues. To amend Routing Tag Groups, Select Console 

Connect > On-line updates > Call Filters > Manage Routing Tag Groups,  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-13 Manage Routing Tag Groups 
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To amend the Routing Tag Groups for Queues, 

 

1. Select Queue from the drop down list. Routing Tag for that Queue and all the routing 

tags for the filters in that Queue will be populated in the box below.  

2. Select a tag from the Call Routing Tag list. 

3. To add a Routing Tag Group, select a group from the Available Groups list to 

Operator Groups list. Click the Add button. 

4. To remove a Routing Tag Group, select a group from the Operator Groups list to 

Available Groups list. Click the Remove button. 

5. Click Update. 

6. Click Exit. 

 

5.4.6 Break Hours 

All the Queues can be given breaks for hours and days of operation. This page sets up the times 

and days of operation for each Console Connect queue. It allows specific days of the week and 

dates to be entered for when a queue will not operate, i.e. Sunday, Christmas Date. 
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To amend Break Hours, select Console Connect > On-line updates > B eak Periods > Manage 

Break Hours  the following window will open, 

r

,

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-14 Manage Break Hours 

To add new Break Hours for Days, 

1. Select the Queue Name from the drop down list. 

2. Click the New button. 

3. Select Day radio button. 

4. Select the Day in which Break is required on weekly basis  

5. Select Reason for the Break. 

6. Set the Break Properties. Select the Start and End Time of the Break.  

7. Set a Forward Destination where calls would be forwarded during the Break Hour. 

8. Click Update button. 

 

To add new Break Hours for Date, 

1. Select the Queue Name from the drop down list. 

2. Click the New button. 

3. Select Date radio button. 

4. Select the Date for the Break. 
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5. Select Reason for the Break. 

6. Set the Break Properties. Select the Start and End Time of the Break.  

7. Set a Forward Destination where calls would be forwarded during the Break Hour. 

8. Click Update button. 

 

To delete a Break Hour period, 

1. Select the Queue Name from the drop down list. 

2. Select the Break Hour period from Day or Date section. 

3. Click Delete. 

4. Click Exit. 

 

To update a Break Hour period, 

1. Select the Queue Name from the drop down list. 

2. Select the Break Hour period from Day or Date section. 

3. Update/Change the Break hour period. 

4. Click Update. 

5. Click Exit. 
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Section 6: Voice Connect 

The sixth folder in the Folder List is Voice Connect. The Voice Connect folder consists of three 

segments, 

1. Monitor Templates 

2. Graphical Analysis 

3. Reports 

4. Online Updates 

 

Voice Connect provides information about the Voice Sessions. The Supervisor can view the 

Graphical reports as well as the Text-based reports. The Supervisor is also allowed to make 

instant online updates.  

 

6.1 Voice Connect Monitor Templates 

The created Monitor Templates follow the same steps as described and explained in Section 4, 

topic 4.1, Monitor Templates. The Monitor Templates created in Voice Connect are slightly 

different from the Monitor Templates of Arc Connect in the sense of Data Items.  

 

Difference between Arc Connect and Voice Connect Monitor Templates 

 

As explained in the topic 4.1 Monitor Templates of Arc Connect, the Data Items included all 

the Users and Queues in all the Arc Connect. In the Voice Connect, the Data Items include only 

the Voice Sessions. 

 

6.2 Voice Connect Graphical Analysis 

The Supervisor can have Graphical Analysed reports based on the historical data. The Graphical 

Analysed information in Voice Connect includes on the following segments, 

1. Overview 
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2. Session 

3. Night Service 

4. Over Flow 

 

To run any of these reports, select the  to open the required segment as,  

• Voice Connect > Graphical Analysis > Over View 

• Voice Connect > Graphical Analysis > Session 

• Voice Connect > Graphical Analysis > Night Service 

• Voice Connect > Graphical Analysis > Over Flow 

Once the criteria have been selected, click the Run Report icon .  

 

Run Report

Figure 6-1 Run Report 
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To run a report, 

1. Select the required report from the Description Area. 

2. Select the relevant Date, Time, and other setting criteria for the report. 

3. Every report has different setting criteria. 

4. Click to run report. 

A sample graphical analysed report generated is as follows, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6-2 A sample of Graphical Analysis Report 

6.2.1 Tool Bar 

The Graphical Analyses report contains a Tool Bar with the following icons, 

 

Control Name Icon Explanation 

Print 
 

Click to print the graph report. 

Copy to Clipboard 
 

Click to copy the graph report. Then manually paste 

the graph in a file. The graph report can be pasted in  

• Word 

• Paint 
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Size 
 

The Report page can be resized as required. The 

options are, 

• Whole Page 

• Page Width 

• 100% 

Scroll Arrows  These arrows allow Supervisor to move in the graph 

report if it has more than one page. 

Percentage 

Selection 

 Supervisor can manually enter the required size for the 

graph report.  

Max. Points per 

Page 

 The number of intervals at the Y-axis and X-axis. 

Normal 
 

This icon is clicked by default.  

You can click it to view the graph in normal mode. 

Rotate 
 

Click to rotate the graph along the axis.  

You will have to place the cursor on the graph and 

rotate it. 

Move 
 

Click to move the graph in required direction(s). 

Move the graph with your cursor. 

Zoom 
 

Click to zoom the graph. 

Depth 
 

Click to increase or decrease the depth of the graph. 

Drag your cursor inwards and outwards for the 

required depth. 

 

6.3 Voice Connect Reports 

The Reports in Console Connect also generate in the same approach as described and explained 

in the Arc Connect Reports, Section 4, and topic 4.2. The Report information in Voice Connect 

includes on the following segments, 

1. Over View 

2. Session 
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To run any of these reports, select the  to open the required segment as,  

• Voice Connect > Reports > Over View 

• Voice Connect > Reports > Session 

 

Difference between Arc Connect Reports and Voice Connect Reports 

The Arc Connect Reports involve all the activities report information that takes place. It shows 

the reports including data for all the modules in Arc Connect. 

 

In Voice Connect, the reports will include information about the Sessions. The reports will display 

the information about the calls specific to the voice Sessions.  

Once the criteria have been selected, click the Run Report icon . This can be chosen from 

the icon field at the top of the Arc Supervisor application or as shown above. 

 

Run Report

Figure 6-3 Click Run Report icon to create a report 

<<TOC 

Arc Connect Supervisor User Guide 

Version 4.1   111 



 

1. Select the required report from the Description area. 

2. Select the relevant Date, Time, and other setting criteria for the report. 

3. Every report has different setting criteria. 

4. Run Report. 

A sample report generated is as follows, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6-4 Sample Report 

6.3.1 Tool Bar 

 

Control Name Icon Explanation 

Print Report  Click to print the report. 

Export Report 
 

Click to export the report in formats, 

• Excel (.xls) 

• Cascading Style Sheet (.css) 

• HTML (.html, .htm) 

• Adobe Acrobat Reader (.pdf) 

• Word (.rtf) 
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Size 
 

The Report page can be resized as required. The 

options are, 

• Whole Page 

• Page Width 

• 100% 

Scroll Arrows  These arrows allow Supervisor to move in the report 

if it is more than one page. 

Percentage 

Selection 

 Supervisor can manually enter the required size for 

the report.  

 

6.4 Voice Connect Online Updates 

Within the Voice Connect, the Supervisor can make On-line Updates in the following segments, 

1. Messages 

2. Voice Scripts 

3. Voice Sessions 

4. In Queue Messages 

5. Call Filters 

6. Break Hours 

 

6.4.1 Messages 

This section allows a supervisor to record messages. A Message is composed of phrases. Here 

the user can record phrases to create messages. Through the messages function, the user can 

perform the following, 

1. Manage Phrases 

2. Manage Messages 
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6.4.1.1 Manage Phrases 

The manage phrase section allows the supervisor to record or play a phrase for a particular 

device. To record or play a particular phrase, the supervisor must be connected to that device. 

To manage the phrases, select Voice Connect > On-line updates > Manage Phrases.  The 

following window will appear. 

 

 

Figure 6-5 Manage phrases 

 

1. Select the type of Phrase from the Phrase type drop down box. 

2. The list of available phrases will be displayed in the Phrase Description text area. 

3. Enter the device on which the phrase is to be recorded or played in the Device text box 

and press the Connect button. 

4. The selected device will be displayed in the text box Phrase Description. 

5. To play the phrase, click the  button. 

6. To record the phrase, click the   button. 

 

6.4.1.2 Manage Messages 

The manage messages section allows the supervisor to record or play a message for a particular 

device. To record or play a particular message on a device, the supervisor must be connected to 

that device. To manage the phrases, select Voice Connect > On-line updates > Manage 

Messages  
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The following window will appear 

 

 

Figure 6-6 Manage Messages 

 

1. Enter the device number in the Local Device text box and press the Connect button. 

2. Select the desired message displayed on the left. 

3. Enter Description of the current messages. 

4. Enter a single or multiple phrases in Start Phrase. 

5. Select a Message Type. It can be Standard, Estimated Answer Time or Queue 

Position. 

6. Enter the final part of the phrase(s) in End Phrase. 

7. Select a Test Value. This selects a value for testing the new IQP or EAT message. The 

value 1 – 60 and First to sixtieth is supported. 

 

 

Start Phrase:  ‘Your call is…’

Message Type:  Queue position 

End Phrase:   ‘in the Queue…’ 

Test Value   3 
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8. To play the phrase, click the  button. 

9. To record the phrase, click the   button 

6.4.2 Voice Scripts 

Voice Scripts allow the user to set up multi-level auto attendant. A box within a script can either 

simply play a message and route the call or it can require a caller to make a decision to help 

route their call to it’s final destination. Single digit tones can be used within a script. The 

supervisor can manage the Voice scripts by selecting Voice Connect> Online updates> Voice 

Scripts> Manage Voice Scripts 

The following window will appear 

 

Figure 6-7 Manage voice scripts 

 

Clicking New will create a new script and a Script Starting Box will be opened 

 

 

Figure 6-8 Script starting box 
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1. Enter the Name of your script. 

2. Enter the type of the script required to display. The options are Message Box or 

Decision Box. Selecting Message Box and Ok will produce an icon on the script 

tree section. 

3. Highlighting this icon and selecting properties will produce the Box entry form, 

 

 

Figure 6-9 Reception 

 

4. Reception window opens up. 

5. Enter Name of the script. 

6. Enter the Description of the script. 

7. Enter the Greeting Message, which the caller will hear at the time of calling. 

8. It displays the default Box Type. 

9. Select an Action how the call will be processed once the greeting has played. 

10. Select Details. These are the details of the action. E.g. if the selected Action is 

transfer to extension, the details section will show a list of all available extensions. 
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11. Selecting Decision Box and Ok will produce an icon on the script tree section. 

Highlighting this icon and selecting properties will produce the Box entry form, 

 

Figure 6-10 Test 

12. Enter Name of the script. 

13. Enter the Description of the script. 

14. It will display the default Decision Box. 

15. Select a Greeting Message that the caller will hear. 

16. In the Digit Options, note that there are 12 possible digits (1 to #), each 

representing the digits on a telephone keypad. Action and details, this decides the 

type of destination for the call. 

17. For multi level auto attendants select Goto Box. The New button will be 

highlighted. Now you can create a new box. Once the box is created, it can be edited 

from the main Voice Scripts tab; any existing boxes will be listed in the details 

section. 

18. Select an User from the list of the currently configured Users in Transfer to User. 

19. Select a Queue from the list of the currently configured Queues in Transfer to 

Queue. 

20. The call will be transferred to the device number that is in the Transfer to Device 

you entered in the Details section. This can be an internal or external number.  

21. For the End Script, the caller will be sent back to the Arc Connect gateway. This is 

mainly used for an in Queue script; the caller will be returned to the queue they 

came from. 

22. Invalid Digits. If the caller presses a digit that has not been configured, i.e. this 

digit has an action setting of None then the actions of the invalid digits section will 

apply. 

23. Maximum Retries. This is the number of attempts that a caller has to enter the 

correct response. 
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24. Message. The message that is played after a caller has pressed an invalid digit. 

25. Action. This action will occur when the maximum retries limit has been exceeded. 

26. Details. The destination for the action. 

27. Time Out. This is the action that will be followed if the caller does not press 

anything. This is also useful if the caller is using a pulse dial phone. 

28. Time out X seconds. The duration of time in seconds that the script will wait 

before the Action will operate. 

29. Action. The required action upon timeout. 

30. Details. The destination for the action. 

 

Please note that once a voice script is updated by using the Update button it will 

become live on your system. A script change only will not require you to stop and 

start your Arc Server. 

 

 

 

 

 

6.4.3 Voice Sessions 

Voice sessions associate voice scripts with the queues. Calls coming into any of the voice sessions 

are directed to voice server so that the associated voice script can be played. To manage the 

voice sessions, select Voice Connect> Voice Session > Manage Voice Sessions. 
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The following screen will appear 

 

 

Figure 6-11 Manage voice session details 

 

1. Once a voice script has been constructed, this screen will allocate a location number to it 

in the same manner as the allocation of a location number to a Queue. Note that 

overflows options can be configured in the same way as a Queue. 

2. Enter the Name of the Session e.g. Welcome. 

3. The next field is the Location. This is the number that will be dialled internally to reach 

this queue. This number cannot be edited. 

4. Select the script description from the Script dropdown box. 

5. Next select the Overflow properties. 

6. Select the forward destination type. 

7. Select the forward destination. 

8. Select the overflow data. 

9. Click Update when done. 

6.4.4 In Queue Messages  

In-Queue Messages informs caller about their current status in the particular queue. This section 

contains the section 

1. Manage In Queue Messages  
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6.4.4.1 Manage In Queue Messages 

Select Voice Connect> Online Updates> Manage In Queue Messages. The following screen will 

appear 

 

 

Figure 6-13 Manage In queue messages 

 

 

To set voice messages on the listed queues, 

1. Click the New button. 

2. Select the desired queue from drop down box. This drop down box will display the list of 

available Console queues. 

3. Select the required message or script to be played from the Play Message or Play 

Script drop down box. 

4. Select the time after which the message would be started playing. 

5. Select the time after which the message would be repeated and also select its duration. 

6. Click the Update button when done. 

 

6.4.5 Call Filters 

Voice Call Filters work in the same way as Console Queue Call Filters. Any filters entered here will 

result in these calls being routed to the Voice Session. The Call filters have a section 

Manage Call Filters. 
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6.4.5.1 Manage Call Filters 

To manage the call filters select Voice Connect> Online Updates> Manage Call Filters. The 

following screen will appear: 

 

 

Figure 6-14 Manage call filters 

1. This section is used to filter incoming calls to their intended destination. 
2. Highlight the session that is the required destination. 
3. Highlight the required filter. 
4. Enter the number criteria in the Number text box.  
5. Enter the required text in the Routing Tag field. Ensure that all required User 

applications have the routing tag enabled in their call information to display this text. 
6. Select a filter from Types of filter. 

 

CLI exact match filter: 
Any calls with this exact CLI will be sent to the required 

Queue. 

CLI pattern match 

filter: 

Any calls matching this CLI pattern will be filtered to the 

required Queue. For example, all calls that are CLI begin 

with 020849884* and are filtered to the required Queue. 

DDI exact match filter: Any calls matching this DDI will be filtered to the required 

Queue. 

DDI pattern match 

filter: 

Any calls matching this DDI pattern will be filtered to the 

required Queue. All calls that’s DDI begins with 020849884* 

will be filtered to the required Queue. 
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Divert exact match 

filter 

All calls that have been diverted from a device to any Pre CT 

Gateway will arrive in the Queue in which this filter is 

applied. 

Divert external call 

filter 

All External calls that have been diverted from a device to 

any Pre CT Gateway and could not be caught by any divert 

filter will arrive in the Queue in which this filter is applied. 

User does not need to give any number in case of this filter. 

This filter will be applied only once in any call queue in the 

system. 

Divert internal call 

filter 

All internal calls that have been diverted from a device to 

any Pre CT Gateway and could not be caught by any divert 

filter will arrive in the Queue in which this filter is applied. 

User does not need to give any number in case of this filter. 

This filter will be applied only once in any call queue in the 

system.  

Divert pattern match 

filter 

All calls that have been diverted from a device (with a 

number that matches the pattern given in this filter) to any 

Pre CT Gateway will arrive in the Queue in which this filter is 

applied. If user has given a number i.e. 300 in this filter then 

all calls from 3005 and 3006 diverted to a Pre CT Gateway 

will arrive in this queue 

No call Divert match 

filter 

All calls that have been diverted from a device to any Pre CT 

Gateway and could not be caught by any divert filter will 

arrive in the Queue in which this filter is applied. User does 

not need to give any number in case of this filter. This filter 

will be applied only once in any call queue in the system. 

This filter will work in the absence of Divert internal call filter 

and Divert external call filter 
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1. Select New. 
2. Highlight the session Welcome. 
3. Select DDI exact match filter. 
4. Enter the DDI number that will be used for Welcome into the Number 

field. 
5. This number will vary according to the DDI digit presentation of the 

switch. I.e. if the full DDI number is 020 8498 7904, then the switch 
will present 7904 if four digit presentation is used. 

6. Enter the required text into the routing tag field. 
7. Multiple filters can apply to a single session. 

 

 

 

 

 

 

 

 

 

6.4.6 Break Hours 

It sets up the times and days of operation for each Voice session. It allows specific days of the 

week and dates to be entered for when a Queue will not operate, i.e. Sunday, Christmas Date. 

The break hours section contains the following option 

Manager Break Hours 

6.4.6.1 Manage Break Hours 

Select Voice Connect > Online Updates > Manage Break Hours. The following window will appear 

 

 

Figure 6-15 Manage break hours 
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To Add New Break Hours for Days, 
 

1. Select the Voice Session Name from the drop down list. 
2. Click the New button. 
3. Select Day radio button. 
4. Select the Day in which Break is required on weekly basis. 
5. Select reason for the Break. 
6. Set the Break Properties. Select the Start and End Time of the Break.  
7. Set a Forward Destination where calls would be forwarded during the Break Hour. 
8. Click Update button. 
9. Newly added Break Hour will be seen in the list. 

 

Note:  

1. Start Time and End Time in Reason section depend on time settings as defined 
in Regional Settings (Windows 98) or Regional Option (Windows 2000) in 
Control Panel. 

 

 

 

2. The default setting for Overflow section is as follows, 
Forward Destination Type: Device 

Forward Destination: 100 

The user is required to change these settings according to requirements and available 

devices. 

 

To Add New Break Hours for Dates, 
 

1. Select the Voice Session name from the drop down list. 
2. Click the New button. 
3. Select Date radio button. 
4. Select the Date for the Break. 
5. Select reason for the Break. 
6. Set the Break Properties. Select the Start and End Time of the Break.  
7. Set a Forward Destination where calls would be forwarded during the Break Hour. 
8. Click Update button. 
9. Newly added Break Hour will be seen in the list. 

 

1. Start Time and End Time in Reason section depend on time settings as defined in 
Regional Settings (Windows 98) or Regional Option (Windows 2000) in Control Panel. 

2. The default setting for Overflow section is as follows, 
a. Forward Destination Type: Device 
b. Forward Destination: 100 
c. The user is required to change these settings according to requirements and 

available devices. 
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Section 7:  Appendices 

7.1 Appendix 1: Running a Report with the Arc Supervisor Application 

When a report folder is opened, the reports associated with that folder are shown in the 

Description field. A number of report criteria are also displayed, as shown below. Not all report 

criteria are available for selection with each report. The ‘unavailable criteria’ is shown greyed-out. 

 

 

Figure 7-1 Running a report 
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7.1.1 Date Selection 

Use the arrows to scroll to the month and year that the report will start from. Click on a number 

to select date. The date then shows in a grey square. Today’s date is automatically selected and 

shown with a red outline. 

 

 

 

 

 

 

 

 

Figure 7-2 Date Selection 

 

• Use the arrows to scroll to the month and year 

• The report in figure will base on figures generated between 14th Sep 2002 – 16th Sep 

2002. 

 

 

 

 

 

 

 

 

 

 

Figure 7-3 Select months 

 

• By clicking on the Date field, a group of months is listed. 

• The current month is shown and selected. 
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• The three months on either side of the current month are also shown. The desired date 

can be selected by moving the mouse up or down the list. 

 

7.1.2 Time Selection 

The user can use the arrows to change the time. By default, the time setting is for one 24 Hour 

day. From 12:00:00 To 11:59:59. 

 

  

 

 

Figure 7-4 Time Selection 

 

7.1.3 Queue Selections 

The user can use the arrows at the end of this field to scroll to the Queue, on data the report will 

be based. Click on the Queue to select.  

 

  

 

 

 

Figure 7-5 Select Queue 

 

• Open the Drop down box to select the Queue. 

• Click on the queue to select. 

• Click to select whether the report will be based on figures for the Arrival Queue or the 

Delivery Queue. 

 

7.1.4 User Selections 

Use the arrows to scroll through the Users, on whose data the report will be based. Click on the 

User name to select. 
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Note: Up to four Users can be displayed in this field without the need for a scroll bar. 

 

 

Figure 7-6 Select Users 

 

• Use the arrows to scroll through the user name if more than four users are configured.  

• Click on the User to select. 

• To select multiple Users, simply select the first User, then while holding down the ctrl 

key select all other User(s). Or Drag the mouse being pressed over the list to select 

multiple Users. 

 

7.1.5 Graph Settings 

These are only available when running Graphical Analysis Reports. Graphical Analysis Reports 

are available for use with each of the Arc Connect products monitored by the Arc Supervisor 

application, Console Connect and Voice Connect. 
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Use the arrows at the end of each field (drop down box) to display the available settings. Click on 

the required setting to select. 

 

  

 

 

 

 

 

 

 

 

 

Figure 7-7 Make Graph settings 

 

• First drop down box is carrying the type of information desired by the user in the Report. 

Clicking on the arrows displays the available settings. 

• Chart type may be Bar, Pie or Line as selected by the User. 

• The settings available in the Period are the intervals on the Graph set by the User. 

 

7.1.6 Abandoned Call Timer 

This functionality will enable the Supervisor to apply filter on the reports, which will discard the 

abandoned calls according to the given time. The supervisor can set the time to abandon a 

particular call through the After time spin button, as shown in the figure 

 

 

Figure 7-8 Abandoned calls 
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7.2 Appendix 2: Arc Connect Reports 

7.2.1 Overview 

There are five historical text reports available in Arc Connect Overview folder. Data shown in 

these reports is based on all the sections of Arc Connect Suite i.e. adding up all the values from 

different modules, and giving a cumulative total. 

7.2.1.1 AC01-Total Incoming and Outgoing Calls By Date 

This is a summary report of all Incoming and Outgoing Calls for all the Arc Connect modules, 

covering a specified date range. A single line of information is provided for each Date. 

 

Field Names Description 

Total Calls Total number of incoming and outgoing calls through Arc Server 

during the Date range selected for the Report. 

Answered Calls Total number of incoming and outgoing calls answered through 

all the modules of Arc Connect. 

Abandoned Calls Total number of incoming and outgoing calls abandoned in all 

the modules of Arc Connect. 

Overflowed Total number of incoming calls overflowed to a device or External 

number from all the modules in Arc Connect. 

% Answered Total number of incoming and outgoing calls answered through 

all the modules of Arc Connect /Total numbers of calls * 100 

% Abandoned To Total number of incoming and outgoing calls abandoned in all 

the modules of Arc Connect /Total numbers of calls * 100 

% Overflowed Total number of incoming calls overflowed to a device or External 

number from all the modules in Arc Connect /Total number of 

calls * 100. 

Average Answered Wait Average time a caller has waited before the call is answered in all 

the modules of Arc Connect. 

Average Answered Talk Average Talk time for Answered Call in all the modules of Arc 

Connect System.  
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Average Wait of Abandoned 

Calls 

Average Wait time for Abandoned Call in all the modules of Arc 

Connect System. This is the average time a caller has waited 

before the call is Abandoned. 

Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10 % Calls answered within 10 seconds. 

� 20 % Calls answered between 10 to 20 seconds. 

� 30 % Calls answered between 20 to 30 seconds. 

� 40 % Calls answered between 30 to 40 seconds. 

� 40 % Calls answered after 40 seconds of wait. 

Longest Wait for Abandoned 

Calls 

Among all the abandoned calls, the longest wait a caller had to 

bear before the call was abandoned. 

Longest Wait for Answered 

Calls 

Among all the answered calls, the longest wait a caller had to 

bear before the call was answered. 

 

The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

 

7.2.1.2 AC02-Total Incoming and Outgoing Calls By Time 

This is a summary report of all Incoming and Outgoing Calls for all the Arc Connect modules, 

covering a specified Time range in a Date selected by the user. A single line of information is 

provided for each hour. 

 

Field Names Description 

Total Calls Total number of call entered in Arc Server during the Date 

selected for the Report. 

Answered Calls Total number of Incoming and Outgoing calls answered in all the 

modules of Arc Connect Suite. 

Abandoned Calls Total number of Incoming and Outgoing calls abandoned in all 

the modules of Arc Connect Suite. 
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Overflowed Total number of Incoming and Outgoing calls overflowed to a 

device or External number in all the modules of Arc Connect 

Suite. 

% Answered Total number of calls answered in all the modules of Arc Connect 

Suite/Total numbers of calls * 100 

% Abandoned Total number of calls abandoned in all the modules in Arc 

Connect Suite/Total numbers of calls * 100 

% Overflowed Total number of calls overflowed to a device or External number 

in all the modules in Arc Connect Suite/Total number of calls * 

100. 

Average Answered Wait Average Wait time for Answered Call in all the modules of Arc 

Connect Suite. This is the average time a caller has waited before 

the call is answered. 

Average Answered Talk Average Talk time for Answered Call in all the modules of Arc 

Connect Suite.  

Average Wait of Abandoned 

Calls 

Average Wait time for Abandoned Call in all the modules of Arc 

Connect Suite. This is the average time a caller has waited before 

the call is Abandoned. 

Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait for Abandoned 

Calls 

Among all the abandoned calls, the longest wait a caller had to 

bear before the call was abandoned. 

Longest Wait for Answered 

Calls 

Among all the answered calls, the longest wait a caller had to 

bear before the call was answered. 
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The following selections are available for this report: 

Date: For: Date of the Report. 

 

7.2.1.3 AC03- Abandoned External Calls Inbound and Outbound 

This report gives details of all abandoned calls Inbound and Outbound, for a specific date 

selected by the user. Name of the Arrival Queue is shown with the call information.  

 

Field Names Description 

Time The Time when the call first rang in the Arc System. 

Queue The Arrival Queue for the incoming call. 

CLI Caller’s Line Identification for the incoming external call. 

DDI Direct Dial Inbound: The number, the caller of the abandoned 

call dialled. 

Ring Duration The Total Time duration for which the call remained in Arc 

System. 

 

The following selections are available for this report: 

Date: For: Date of the Report. 

Time: From: Start Time, To: End Time. 

 

7.2.1.4 AC04- Call Routing by Date 

This is a summary report for each Call Filter used for routing calls into queues, covering a 

specified date range selected by the user. The information provided covers the Routing Tag and 

Reference assigned to the filter. Each line is given to a specified filter. 

 

Field Names Description 

Call Filter Number of the Filter applied to the Group of Calls. 

Routing Tag Routing Tag with the applied filter. 

Reference for Filter This is the name of the Queue on which the filter is applied. 

 

<<TOC 

   

    134 



 

Total Calls Total number of call entered in Arc Server for the Date range 

selected. 

Answered Calls Total number of incoming calls answered in all the modules in 

Arc Connect System.  

Abandoned Calls Total number of calls abandoned in all the modules in Arc 

Connect System. 

Overflowed Total number of incoming calls overflowed to a device or External 

number in all the modules in Arc Connect Suite. 

% Answered Total number of incoming calls answered in all the modules in 

Arc Connect System/Total numbers of calls * 100 

% Abandoned Total number of incoming calls Abandoned in all the modules in 

Arc Connect System/Total numbers of calls * 100 

% Overflowed Total number of incoming calls overflowed to a device or External 

number in all the modules in Arc Connect System/Total number 

of calls * 100 

 

The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

 

7.2.1.5 AC05- Call Routing by Time 

This is a summary report for each Call Filter used for routing calls into queues, for a specified 

date selected by the user. The information provided covers the Routing Tag and Reference 

assigned to the filter. 

 

Field Names Description 

Time The Hour for which the calls are grouped together. 

Call Filter Number of the Filter applied to the Group of Calls. 

Routing Tag Routing Tag with the applied filter. 

Reference for Filter This is the name of the Queue on which the filter is applied. 
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Total Calls Total number of call entered in Arc Server for the Date range 

selected. 

Answered Calls Total number of incoming calls answered in all the modules in 

Arc Connect Suite.  

Abandoned Calls Total number of calls abandoned in all the modules in Arc 

Connect Suite. 

Overflowed Total number of incoming calls overflowed to a device or External 

number in all the modules in Arc Connect Suite. 

% Answered Total number of incoming calls answered in all the modules in 

Arc Connect System/Total numbers of calls * 100 

% Abandoned Total number of incoming calls Abandoned in all the modules in 

Arc Connect System/Total numbers of calls * 100 

% Overflowed Total number of incoming calls overflowed to a device or External 

number in all the modules in Arc Connect System/Total number 

of calls * 100 

 

The following selections are available for this report: 

Date: For: Date of the Report. 

 

7.2.2 Call Tracking 

There are five Historical Text reports present in Arc Connect Call Tracking folder. These reports 

track calls based on CLI and DDI information. Data fetched by these reports is based on the all 

the modules of Arc Connect Suite. 

 

7.2.2.1 CT01-CLI Call Tracking 

This is a Tracking report of Incoming Calls based on the CLI. User gives the Number, and 

Supervisor application will produce a report for all the incoming calls that has CLI matched with 

the given number. The information provided covers Date/Time of the Call, Event, and Route of 

the Call. Complete routing information is provided for each of the call. 
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Field Names Description 

Date/Time Date and Time when the event has occurred on this call. 

Event Event that has occurred on the call. 

Routed To The name of the destination where the call is forwarded. 

 

The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

Input CLI number or CLI pattern. 

 

7.2.2.2 CT02-CLI Call Tracking Summary 

This is a Summary report of Incoming Calls based on the CLI. User gives the Number, and 

Supervisor application will produce a report for all the incoming calls that has CLI matched with 

the given number. The information provided covers Date/Time of the Call, Event, and Route of 

the Call.  

 

Field Names Description 

CLI Caller’s number. 

Date Date when the call first entered in Arc System. 

Time Time when the call first entered in Arc System. 

Outcome Outcome of the Call. 

Ringing in Time Wait time for the call before being answered or abandoned. 

Connected Time In case the call is answered then the talk time will be shown in 

this column. 

 

The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

Input CLI number or CLI pattern. 
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7.2.2.3 CT03-DDI Call Tracking 

This is a Tracking report of Incoming Calls based on the DDI. User gives the Number, and 

Supervisor application will produce a report for all the incoming calls that has DDI matched with 

the given number. The information provided covers Date/Time of the Call, Event, and Route of 

the Call. Complete routing information is provided for each of the call. 

 

Field Names Description 

Date/Time Date and Time, when the event has occurred on this call. 

Event Event that has occurred on the call. 

Routed To The name of the destination where the call is forwarded. 

 

The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

Input DDI number or DDI pattern. 

 

7.2.2.4 CT04-DDI Call Tracking Summary  

This is a summary report of Incoming Calls based on the DDI. User gives the Number, and 

Supervisor application will produce a summary report for all the incoming calls that has DDI 

matched with the given number. The information provided covers Total Calls, Date/Time of the 

Call, Outcome, Ringing in Time, Connected Time. 

 

Field Names Description 

DDI The number Caller has dialled.   

Date Date when the call first entered in Arc System. 

Time Time when the call first entered in Arc System. 

Outcome Outcome of the Call. 

Ringing in Time Wait time for the call before being answered or abandoned. 

Connected Time In case the call is answered then the talk time will be shown in 

this column. 
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The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

Input DDI number or DDI pattern. 

 

7.2.2.5 CT05- External Transfer Tracking Report  

This is a summary report of all incoming Calls that have been transferred on any of the External 

number through Arc System based on the CLI. User gives the Number, and Supervisor 

application will produce a summary report for all the incoming and transferred calls that have CLI 

matched with the given number. The information provided covers CLI, Date/Time of the Call, 

User and Transfer Destination. 

 

Field Names Description 

CLI Caller’s number for this call.  

Date Date when the call first entered in Arc System. 

Time Time when the call first entered in Arc System. 

User Name of the User who has transferred the call 

Transferred To The external number where the user transferred the call. 

 

The following selections are available for this report: 

Date Selection: From: Start Date, To: End Date. 

Input CLI number or CLI pattern. 

 

7.3 Appendix 3: Console Connect Reports 

A wide range of historical text reports is also available in Console Connect section. These reports 

cover all areas of Console Connect, and are defined in the following folders: - 

1. Queue  

2. Operator  
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7.3.1 Console Connect Graphical Analysis 

With Current Activity graphs, a wide range of historical graphs is also available in Console 

Connect section. 

 

These cover all areas of Console Connect, and are defined in the following folders: 

1. Queue  

2. Operator  

3. Overflow  

 

7.3.1.1 Queue Graphs 

Report – CNQG01 – CNQG11: Call Details by Time Period. 

There are 11 queue graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 11 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar and Line. 

Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year. Choices in the 

Call Details include: - 

1. No. of Calls 

2. Answered Calls 

3. Abandoned Calls 

4. Average Wait for all calls 

5. Average Wait for answered calls 

6. Average Wait for abandoned calls 

7. Longest wait for all calls 

8. Longest wait for answered calls 

9. Longest wait for abandoned calls 

10. Average duration for Answered Calls 

11. Longest duration for abandoned Calls 
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Report – CNQG12 – CNQG22: Call Details by Time Period. 

There are 11 queue graphs available. To run a graph double clicks on the graph report name in 

the Description panel. There are 11 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar, Pie and Line. 

Choices in the Call Details include: 

1. No. of Calls 

2. Answered Calls 

3. Abandoned Calls 

4. Average Wait for all calls 

5. Average Wait for answered calls 

6. Average Wait for abandoned calls 

7. Longest wait for all calls 

8. Longest wait for answered calls 

9. Longest wait for abandoned calls 

10.  Average duration for Answered Calls 

11.  Longest duration for abandoned Calls 

 

7.3.1.2 Operator Graphs 

Report – CNOP01 – CNOP8: Call Details by Time Period. 

There are 8 Operator graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 8 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar and Line. 

Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year. Choices in the 

Call Details include: - 

1. No. of Inbound Calls 

2. Duration of Inbound Calls 

3. Average duration for Inbound Calls 

4. Longest duration for Inbound Calls 
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5. No. of Outbound Calls 

6. Duration of Outbound Calls 

7. Average duration for Outbound Calls 

8. Longest duration for Outbound Calls 

 

Report – CNOP09 – CNOP12: Call Details for a specific queue with queue totals by 

time period. 

There are 4 Operator graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 4 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar and Line. 

Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year. Queue is 

selectable before running a graph.  

Choices in the Call Details include: - 

1. No. of Inbound Calls 

2. Duration of Inbound Calls 

3. Average duration for Inbound Calls 

4. Average duration for Inbound Calls 

 

Report – CNOP13 – CNOP16: Consolidated Call Details for a specific queue. 

There are 4 Operator graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 4 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar, Pie and Line. 

Queue is selectable before running a graph.  

Choices in the Call Details include: - 

1. No. of Inbound Calls 

2. Duration of Inbound Calls 

3. Average duration for Inbound Calls 

4. Average duration for Inbound Calls 
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Report – CNOP17 – CNOP24: Consolidated Call Details for a specific Queue. 

There are 8 Operator graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 8 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. 

 

Available Graph types are Bar, Pie and Line. Operator(s) is selectable before running a graph.  

Choices in the Call Details include: - 

1. No. of Inbound Calls 

2. Duration of Inbound Calls 

3. Average duration for Inbound Calls 

4. Average duration for Inbound Calls 

5. No. of Outbound Calls 

6. Duration of Outbound Calls 

7. Average duration for Outbound Calls 

8. Longest duration for Outbound Calls 

 

Report – CNOP25: Operator Activity by Time period. 

One graph is available under this title. To run the graph, double click on the graph report name 

in the Description panel. There is only one choice available (as Call Details) in the drop down box 

in Graph setting. Data on this report is shown as Time intervals on X-Axis and Information 

(Operator Activity type as selected by the user) on Y-Axis. Available Graph types are Bar and 

Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

Choice for the Call Details is Call Time. 
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Report – CNOP26: Consolidated Operator Activity. 

One graph is available under this title. To run the graph, double click on the graph report name 

in the Description panel. There is only one choice available (as Call Details) in the drop down box 

in Graph setting. Data on this report is shown as Time intervals on X-Axis and Information 

(Operator Activity type as selected by the user) on Y-Axis. Available Graph types are Bar and 

Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

Operator(s) is selectable before running a graph.  

Choice for the Call Details is Call Time. 

 

7.3.1.3 Overflow Graphs 

Report – CNOG01: No. of Overflow Calls In. 

This Graph report shows the total number of overflowed calls in a queue. To run a graph, double 

click on the graph report name in the Description panel. Data on this report is shown as Time 

intervals on X-Axis and number of overflowed calls on Y-Axis. Available Graph types are Bar and 

Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One queue is selectable before running a graph. 

Report Date range is selectable. 

 

Report – CNOG02: No. of Overflow Calls Out. 

This Graph report shows the total number of overflowed calls out of the queue. To run a graph, 

double click on the graph report name in the Description panel. Data on this report is shown as 

Time intervals on X-Axis and number of overflowed calls on Y-Axis. Available Graph types are Bar 

and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One queue is selectable before running a graph.  

Report Date range is selectable. 

 

Report – CNOG03: Percentage of Overflow Calls - Calls In. 

This Graph report shows the Percentage of overflowed calls in a queue. To run a graph, double 

click on the graph report name in the Description panel. Data on this report is shown as Time 

intervals on X-Axis and Percentage of overflowed calls on Y-Axis. Available Graph types are Bar 

and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One queue is selectable before running a graph.  

Report Date range is selectable. 
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Report – CNOG04: Percentage of Overflow Calls - Calls Out. 

This Graph report shows the total Percentage of overflowed calls out of the queue. To run a 

graph, double click on the graph report name in the Description panel. Data on this report is 

shown as Time intervals on X-Axis and Percentage of overflowed calls on Y-Axis. Available Graph 

types are Bar and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months 

and Year.  

One queue is selectable before running a graph.  

Report Date range is selectable. 

 

7.3.2 Overview 

There are five reports present in Console Connect Overview folder. These are the Historical Text 

reports. Data shown in these reports is based on the Console Connect module.  

 

7.3.2.1 CN01-Incoming Calls By Date 

This is a summary report of Incoming Call Data, covering a specified date range. A single line of 

information is provided for each 24-hour period. 
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Field Names Description 

Queue Type It displays the Queue for which the report is being generated. 

Total Calls Total number of call entered in Console Connect. During the Date 

range selected for the Report. 

Answered Calls Total number of calls answered in the Console Connect.  

Abandoned Calls Total number of calls abandoned in the Console Connect. 

Overflowed Calls Total number of calls overflowed to a device or External number 

in the Console Connect. 

% Answered Total number of calls answered in Console Connect/Total 

numbers of calls * 100. 

% Abandoned Total number of calls abandoned in Console Connect/Total 

numbers of calls * 100. 

% Overflowed Total number of calls overflowed to a device or External number 

in all the modules in Console Connect/Total number of calls * 

100. 

Average Answered Wait Average Wait time for Answered Call in Console Connect. This is 

the average time a caller has waited before the call is answered. 

Average Answered Talk 

Time 

Average Talk time for Answered Call in Console Connect.  

Average Wait of Abandoned 

Calls 

Average Wait time for Abandoned Call in the Console Connect. 

This is the average time a caller has waited before the call is 

Abandoned. 
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Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Arrival or Delivery Queue type is selectable before running the report. 

Date Selection: From: Start Date; To: End Date. 

 

7.3.2.2 CN02-Incoming Calls By Time 

This is a summary report of Incoming Call Data, covering a specified time. A single line of 

information is provided for each hour. 

 

Field Names Description 

Total Calls Total number of calls entered in Console Connect. During the 

date range selected for the Report. 

Answered Calls Total number of incoming calls answered in Console Connect 

within a specified time. 

Abandoned Calls Total number of calls abandoned in Console Connect for the 

specified time range. 

Overflowed Calls Total number of calls overflowed to a device or External number 

in Console Connect. 
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% Answered Total number of incoming calls answered in Console 

Connect/Total numbers of calls * 100. 

% Abandoned Total number of calls Abandoned in Console Connect/Total 

numbers of calls * 100. 

% Overflowed Total number of calls Overflowed in all the Console Connect/Total 

numbers of calls * 100. 

Average Answered Wait Average Wait time for Answered Call in Console Connect. This is 

the average time a caller has waited before the call is answered. 

Average Answered Talk Average Talk time for Answered Call in the Console Connect. 

Average Wait of Abandoned 

Calls 

Average Wait time for Abandoned Call in Console Connect. This is 

the average time a caller has waited before the call is 

Abandoned. 

Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Arrival or Delivery Queue type is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 
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7.3.2.3 CN03-Abandoned Calls CLI Report 

This is a report that gives details of all abandoned calls, for a specific date. Totals are given per 

Queue. Only calls with a valid CLI are included.  

 

Field Names Description 

Time  The Time when the call first rang in the Console Connect. 

Queue The arrival Queue for the incoming call. 

CLI  Caller’s Line Identification for the incoming external call. 

DDI  Direct Dial Inbound. The number the caller of the abandoned call 

dialled. 

Ring Duration The Total Time duration for which the call remained in Console 

Connect. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time: From: Start Time; To: End Time. 

 

7.3.2.4 CN04-Call Routing By Date 

This is a summary report for each Call Filter used for routing calls into queues, covering a 

specified date range. Totals are given for each Call Filter and for each date in range. 

 

Field Names Description 

Call Filter Name of the Filters applied to the Group of Calls. 

Routing Tag Routing Tag with the applied filter. 

Reference for Filter This is normally the name of the Queue on which the filter is 

applied. 

Total Calls Total number of calls entered in Console Connect. During the 

Data range selected for the Report. 

Answered Calls Total number of calls answered in Console Connect.  

Abandoned Calls Total number of calls abandoned in Console Connect. 
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Overflowed Calls Total number of calls overflowed to a device or External number 

in the Console Connect. 

Calls sent to Night Service The total number of calls that have fallen in the Break Hours. 

% Answered Total number of calls answered in Console Connect /Total 

numbers of calls * 100 

% Abandoned Total number of calls Abandoned in Console Connect/Total 

numbers of calls * 100 

 

The following selections are available for this report: 

Arrival or Delivery Queue type is selectable before running the report. 

Date Selection: From: Start Date; To: End Date. 

 

7.3.2.5 CN05-Call Routing By Time 

A summary report for each Call Filter used for routing calls into queues, for a specific date. A 

single line of information is provided for each hour. Totals are given for each Call Filter and for 

the selected date. 

 

Field Names Description 

Call Filter Name of the Filters applied to the Group of Calls. 

Routing Tag Routing Tag with the applied filter. 

Reference for Filter This is normally the name of the Queue on which the filter is 

applied. 

Total Calls Total number of calls entered in Console Connect. During the 

Data range selected for the Report. 

Answered Calls Total number of calls answered in Console Connect.  

Abandoned Calls Total number of calls abandoned in Console Connect. 

Overflowed Calls Total number of calls overflowed to a device or External number 

in Console Connect. 

Calls sent to Night Service The total number of calls that have fallen in the Break Hours. 
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% Answered Total number of calls answered in Console Connect/Total 

numbers of calls * 100 

% Abandoned Total number of calls Abandoned in Console Connect/Total 

numbers of calls * 100 

 

The following selections are available for this report: 

Arrival or Delivery Queue type is selectable before running the report. 

Date: For: Date of the Report. 

Time: From: Start Time; To: End Time. 

 

7.3.2.6 CN06-Abandoned Calls Overview By Date 

An overview summary report for the calls in the Queues, for a specific date. A single line of 

information is provided for each hour.  

 

Field Names Description 

For Queue It displays the Queue’s name for which the report is generated. 

Date Displays the date. 

Total Calls Total number of calls entered in Console Connect. During the 

Data range selected for the Report. 

Answered Calls Total number of calls answered in Console Connect.  

Abandoned Calls Total number of calls abandoned in Console Connect. 

% Answered Total number of calls answered in Console Connect/Total 

numbers of calls * 100 

% Abandoned Total number of calls Abandoned in Console Connect/Total 

numbers of calls * 100 

Average Answered Wait Average Wait time for Answered Call in Console Connect. This is 

the average time a caller has waited before the call is answered. 

Average Answered Talk Average Talk time for Answered Call in the Console Connect. 
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Average Abandoned Wait Average Wait time for Abandoned Call in Console Connect. This is 

the average time a caller has waited before the call is 

Abandoned. 

% Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 

 

The following selections are available for this report: 

Arrival or Delivery Queue type is selectable before running the report. 

Date: For: Date of the Report. 

Time: From: Start Time; To: End Time. 

 

7.3.2.7 CN07-Abandoned Calls Overview By Time 

An overview summary report for the calls in the Queues, for a specific date and time. A single 

line of information is provided for each hour. 

 

Field Names Description 

For Queue It displays the Queue’s name for which the report is generated. 

Time Displays the time. 

Total Calls Total number of calls entered in Console Connect. During the 

Data range selected for the Report. 

Answered Calls Total number of calls answered in Console Connect.  

Abandoned Calls Total number of calls abandoned in Console Connect. 
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% Answered Total number of calls answered in Console Connect/Total 

numbers of calls * 100 

% Abandoned Total number of calls Abandoned in Console Connect/Total 

numbers of calls * 100 

Average Answered Wait Average Wait time for Answered Call in Console Connect. This is 

the average time a caller has waited before the call is answered. 

Average Answered Talk Average Talk time for Answered Call in the Console Connect. 

Average Abandoned Wait Average Wait time for Abandoned Call in Console Connect. This is 

the average time a caller has waited before the call is 

Abandoned. 

% Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 

 

The following selections are available for this report: 

Arrival or Delivery Queue type is selectable before running the report. 

Date: For: Date of the Report. 

Time: From: Start Time; To: End Time. 

 

7.3.2.8 CN08-Incoming Calls by Date and Time 

An overview summary report for the incoming calls in the Queues, for a specific date and time. A 

single line of information is provided for a particular date and time duration. 
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Field Names Description 

For Queue It displays the Queue’s name for which the report is generated. 

Queue Type Type of queue receiving calls. 

Hour Displays the time. 

Date Displays the date. 

Total Calls Total number of calls entered in Console Connect. During the 

Data range selected for the Report. 

Answered Calls Total number of calls answered in Console Connect.  

Abandoned Calls Total number of calls abandoned in Console Connect. 

Overflowed Total number of Incoming calls overflowed to a device or 

External number in all the modules of Arc Connect Suite. 

% Answered Total number of calls answered in Console Connect/Total 

numbers of calls * 100 

% Abandoned Total number of calls Abandoned in Console Connect/Total 

numbers of calls * 100 

%Overflowed Total number of calls Overflowed in Console Connect/Total 

numbers of calls * 100 

Average Answered Wait Average Wait time for Answered Call in Console Connect. This is 

the average time a caller has waited before the call is answered. 

Average Answered Talk Average Talk time for Answered Call in the Console Connect. 

Average Abandoned Wait Average Wait time for Abandoned Call in Console Connect. This is 

the average time a caller has waited before the call is 

Abandoned. 

<<TOC 

   

    154 



 

% Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Abandoned Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was abandoned. 

Longest Answered Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 

 

7.3.3 Queue 

There are seven reports present in Console Connect Queue folder. These are the Historical Text 

reports. Data shown in these reports is based on the Queues configured in Console Connect 

module. 
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7.3.3.1 CS01-Incoming Calls By Queue/Date 

This is a summary report of Incoming Call Data, covering a specified date range. A single line of 

information is provided for each 24-hour period. 

 

Field Names Description 

Total Calls Total number of calls entered in Console Connect. During the 

Date range selected for the Report. 

Answered Calls Total number of calls answered for selected Queue(s) in Console 

Connect.  

Abandoned Calls Total number of calls abandoned for selected Queue(s) in 

Console Connect. 

Overflowed Calls Total number of calls overflowed to a device or External number 

for selected Queue(s) in Console Connect. 

% Answered Total number of calls answered for selected Queue(s) in Console 

Connect/Total numbers of calls * 100 

% Abandoned Total number of calls Abandoned for selected Queue(s) in 

Console Connect/Total numbers of calls * 100 

% Overflowed Total number of calls Overflowed for selected Queue(s) in 

Console Connect/Total numbers of calls * 100. 

Average Answered Wait Average Wait time for Answered Call for selected Queue(s) in 

Console Connect. This is the average time a caller has waited 

before the call is answered. 

Average Answered Talk Average Talk time for Answered Call for selected Queue(s) in the 

Console Connect. 

Average Wait of Abandoned 

Calls 

Average Wait time for Abandoned Call for selected Queue(s) in 

Console Connect. This is the average time a caller has waited 

before the call is Abandoned. 
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Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait Among all the answered calls in a selected Queue, the longest 

wait a caller has to bear before the call was answered. 

Longest Talk The duration of answered calls, which were talked over more 

than the normal answering time. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Arrival or Delivery Queue type is selectable before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.3.3.2 CS02-Incoming Calls By Queue/Time 

This is a summary report of Incoming Calls for a queue, covering a specified date range. A single 

line of information is provided for each hour. 

 

Field Names Description 

Total Calls Total number of calls entered in Console Connect. During the 

Date range selected for the Report. 

Answered Calls Total number of calls answered for selected Queue(s) in a 

specified time.  

Abandoned Calls Total number of calls abandoned for selected Queue(s) in 

specified time. 

Overflowed Calls Total number of calls overflowed to a device or External number 

for selected Queue(s) in specified time. 

 

<<TOC 

Arc Connect Supervisor User Guide 

Version 4.1   157 



 

% Answered Total number of calls answered for selected Queue(s) in specified 

time /Total numbers of calls * 100 

% Abandoned Total number of calls Abandoned for selected Queue(s) in 

specified time /Total numbers of calls * 100 

% Overflowed Total number of calls Overflowed for selected Queue(s) in 

specified time /Total numbers of calls * 100. 

Average Answered Wait Average Wait time for Answered Call for selected Queue(s) in 

specified time. This is the average time a caller has waited before 

the call is answered. 

Average Answered Talk Average Talk time for Answered Call for selected Queue(s) in the 

specified time. 

Average Wait of Abandoned 

Calls 

Average Wait time for Abandoned Call for selected Queue(s) in 

specified time. This is the average time a caller has waited before 

the call is Abandoned. 

Answer Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait. 

Longest Wait Among all the answered calls in a selected Queue, the longest 

wait a caller has to bear before the call was answered. 

Longest Talk The duration of answered calls, which were talked over more 

than the normal answering time. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Arrival or Delivery Queue type is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 
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7.3.3.3 CS03-Queue Activity By Time 

This is a summary report of activities for a queue, covering a specified date. A single line of 

information is provided for each Call. 

 

Field Names Description 

Queue It displays the name of the Queue for which the report is 

generated. 

Start Time The start time for the answering of calls in a Queue. 

End Time The end time for answering the calls in a Queue. 

Talk Time The total time during which the talk was held. 

CLI Caller’s Line Identification for the incoming external call in the 

Queue. 

DDI Direct Dial Inbound. The number the caller of the abandoned call 

dialled to the Queue. 

Destination It displays the name of the destination in the Queue to which the 

call was directed. 

Outcome It displays the results of the call. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 
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7.3.3.4 CS04-Overflowed Calls By Date 

This is a summary report of overflowed calls for a queue, covering a specified date range. A 

single line of information is provided for each Queue/date. 

 

Field Names Description 

Queue It displays the name of the Queue for which the report is 

generated. 

Total Queue Calls The total number of incoming calls in a Queue. 

Total Overflow In The total number of calls overflowed in a respective Queue. 

Overflow In The number of calls overflowed in the selected Queue from other 

call Queues during business hours. 

Night Service In The number of calls overflowed in the Queue during the break 

hours. 

Overflow out Time Limit It displays the number of calls, which were overflowed out to the 

other selected Queues. Reason being that the time for a call 

waiting to be answered exceeded the limit. 

Overflow out Queue Limit It displays the number of calls, which were overflowed out to 

other Queues. Reason being that the Queue could no more take 

the calls. 

Overflow out No Users The number of calls that overflowed to other destination due to 

no Users available to answer the call in the Queue. 

Overflow out Destination 

Time Limit 

The destination to which the calls were overflowed during the 

Time limit. 

Overflow out Destination 

Queue Limit 

The destination to which the calls were overflowed during the 

Queue limit. 

Overflow out Destination No 

Users 

The destination to which the calls were overflowed when there 

were no Users available in the default Queue. 

Night Service Out The number of calls that were overflowed out during the break 

hours to other selected Queue(s). 
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Night Service Out 

Destination 

The destination to which the calls are overflowed out during the 

break hours. 

% In The calculated percentage of the Overflowed In calls. 

% Out The calculated percentage of the Overflowed Out calls. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date Selection: From: Start Date: To: End Date. 

7.3.3.5 CS05-Overflowed Calls By Time 

This is a summary report of overflowed calls for a queue, covering a specified date. A single line 

of information is provided for each hour. 

 

Field Names Description 

Queue It displays the name of the Queue for which the report is 

generated. 

Total Queue Calls The total number of incoming calls in a Queue. 

Total Overflow Queue Calls The total number of calls overflowed in a respective Queue. 

Overflow In The number of calls overflowed in the selected Queue from other 

call Queues during business hours. 

Night Service In The number of calls overflowed in the Queue during the break 

hours. 

Overflow out Time Limit It displays the number of calls, which were overflowed out to the 

other selected Queues. Reason being that the time for a call 

waiting to be answered exceeded the limit. 

Overflow out Queue Limit It displays the number of calls, which were overflowed out to 

other Queues. Reason being that the Queue could no more take 

the calls. 

Overflow out No Users The number of calls that overflowed to other destination due to 

no Users available to answer the call in the Queue. 
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Night Service Out The number of calls that were overflowed out during the break 

hours to other selected Queue(s). 

Night Service Out Total Total number of calls overflowed out during the break hours. 

% In The calculated percentage of the Overflowed In calls. 

% Out The calculated percentage of the Overflowed Out calls. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 

 

7.3.3.6 CS06-Night Service Calls By Date 

This is a summary report of Night Service calls for a queue, covering a specified date range. A 

single line of information is provided for each Queue/date. 

Field Names Description 

Queue It displays the name of the Queue for which the report is 

generated. 

Total Overflow Queue Calls The total number of calls overflowed in a respective Queue. 

Overflow In  The number of calls overflowed in the selected Queue from other 

call Queues during business hours. 

Night Service In The number of calls overflowed in the Queue during the break 

hours. 

% Calls In The calculated percentage of the calls overflowed in. 

Overflow Out The number of calls overflowed out. 

Night Service Out The number of calls that were overflowed out during the break 

hours to other selected Queue(s). 

% Calls Out The calculated percentage of calls overflowed out. 

Night Service Destination The destination to which the calls are overflowed during the 

break hours. 
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The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.3.3.7 CS07-Night Services Calls By Time 

This is a summary report of Night Service calls for a queue, covering a specified date. A single 

line of information is provided for each hour. 

 

Field Names Description 

Queue It displays the name of the Queue for which the report is 

generated. 

Total Overflow Queue Calls The total number of calls overflowed in a respective Queue. 

Overflow In  The number of calls overflowed in the selected Queue from other 

call Queues during business hours. 

Night Service In The number of calls overflowed in the Queue during the break 

hours. 

Overflow Out Time Limit It displays the number of calls, which were overflowed out to the 

other selected Queues. Reason being that the time for a call 

waiting to be answered exceeded the limit. 

Overflow Out Queue Limit It displays the number of calls, which were overflowed out to 

other Queues. Reason being that the Queue could no more take 

the calls. 

Overflow Out No Users The number of calls that overflowed to other destination due to 

no Users available to answer the call in the Queue. 

Overflow Out Total Total number of calls overflowed out. 

Night Service Out The number of calls that were overflowed out during the break 

hours to other selected Queue(s). 

% In The calculated percentage of the Overflowed In calls. 

% Out The calculated percentage of the Overflowed Out calls. 
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The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 

 

7.3.3.8 CS08-Abandoned Calls by Queue/date 

This is a summary report of the abandoned calls by queue/date. A single line of information is 

provided for each hour. 

Field Names Description 

Total Calls Total number of calls entered in Console Connect. During the 

Date range selected for the Report. 

Answered Calls Total number of calls answered for selected Queue(s) in Console 

Connect.  

Abandoned Calls Total number of calls abandoned for selected Queue(s) in 

Console Connect. 

Overflowed Calls Total number of calls overflowed to a device or External number 

for selected Queue(s) in Console Connect. 

% Answered Total number of calls answered for selected Queue(s) in Console 

Connect/Total numbers of calls * 100 

% Abandoned Total number of calls Abandoned for selected Queue(s) in 

Console Connect/Total numbers of calls * 100 

% Overflowed Total number of calls Overflowed for selected Queue(s) in 

Console Connect/Total numbers of calls * 100. 

Average Abandoned Time Average Abandon Time for Abandoned Calls for selected 

Queue(s) in Console Connect. This is the average time a caller 

has waited before the call is Abandoned. 
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Abandon Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls abandoned within 10 seconds. 

� 20: % Calls abandoned between 10 to 20 seconds. 

� 30: % Calls abandoned between 20 to 30 seconds. 

� 40: % Calls abandoned between 30 to 40 seconds. 

� 40: % Calls abandoned after 40 seconds of wait. 

Longest Abandon Wait Among all the abandoned calls in a selected Queue, the longest 

time taken before the call was abandoned. 

 

The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 
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7.3.3.9 CS09-Abandoned Calls by Queue/time 

This is a summary report of the abandoned calls by queue/time. A single line of information is 

provided for each hour. 

 

Field Names Description 

Total Calls Total number of calls entered in Console Connect. During the 

Date range selected for the Report. 

Answered Calls Total number of calls answered for selected Queue(s) in Console 

Connect.  

Abandoned Calls Total number of calls abandoned for selected Queue(s) in 

Console Connect. 

Overflowed Calls Total number of calls overflowed to a device or External number 

for selected Queue(s) in Console Connect. 

% Answered Total number of calls answered for selected Queue(s) in Console 

Connect/Total numbers of calls * 100 

% Abandoned Total number of calls Abandoned for selected Queue(s) in 

Console Connect/Total numbers of calls * 100 

% Overflowed Total number of calls Overflowed for selected Queue(s) in 

Console Connect/Total numbers of calls * 100. 

Average Abandoned Time Average Abandon Time for Abandoned Calls for selected 

Queue(s) in Console Connect. This is the average time a caller 

has waited before the call is Abandoned. 

Abandon Time Profile These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls abandoned within 10 seconds. 

� 20: % Calls abandoned between 10 to 20 seconds. 

� 30: % Calls abandoned between 20 to 30 seconds. 

� 40: % Calls abandoned between 30 to 40 seconds. 

� 40: % Calls abandoned after 40 seconds of wait. 

Longest Abandon Wait Among all the abandoned calls in a selected Queue, the longest 

time taken before the call was abandoned. 
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The following selections are available for this report: 

Queue (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time 

7.3.4 Operator 

There are five reports present in Arc Connect Operator folder. These are the Historical Text 

reports. Data shown in these reports is based on the all the sections of Arc Connect Suite. 

 

7.3.4.1 CO01- Operator Calls by Date 

This is a summary report of Incoming and Outbound Calls for Operators in Console Connect, 

covering a specified date range. A single line of information is provided for each Operator calls. 

Totals are given for each date/report. 

 

Field Names Description 

Total Calls Total number of calls attended by the Operator. 

Console Total number of Console Queue calls attended by the Operator. 

Others Total number of calls other than the Console attended by the 

Operator. 

Inbound Total talk time Total Talk time for the Inbound calls. 

Inbound Average talk time Average Talk time for the Inbound calls. 

Inbound Longest talk time Longest Talk time for the Inbound calls. 

Total Outbound Calls Total number of Outbound calls attended by the Operator. 

Outbound Total talk time Total Talk time for the Outbound calls. 

Outbound Average talk time Average Talk time for the Outbound calls. 

Outbound Longest talk time Longest Talk time for the Outbound calls. 

 

The following selections are available for this report: 

Queue (s) is to be selected by the user before running the report. 

Operator(s) is to be selected by the user before running the report. 

Date Selection: From: Start Date: To: End Date. 
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7.3.4.2 CO02- Operator Calls by Date 

This is a summary report of Incoming and Outbound Calls for Users in Console Connect, covering 

a specified date range. A single line of information is provided for each hour. Totals are given 

each hour date. 

 

Field Names Description 

Total Calls Total number of calls attended by the Operator. 

Console Total number of Console Queue calls attended by the Operator. 

Others Total number of calls other than the Console attended by the 

Operator. 

Inbound Total talk time Total Talk time for the Inbound calls. 

Inbound Average talk time Average Talk time for the Inbound calls. 

Inbound Longest talk time Longest Talk time for the Inbound calls. 

Total Outbound Calls Total number of Outbound calls attended by the Operator. 

Outbound Total talk time Total Talk time for the Outbound calls. 

Outbound Average talk time Average Talk time for the Outbound calls. 

Outbound Longest talk time Longest Talk time for the Outbound calls. 

 

The following selections are available for this report: 

User(s) is to be selected by the user before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.3.4.3 CO03- Operator Calls by Queue 

This is a summary report of Outbound Calls for Operators in Console Connect, covering a 

specified date range. The information provided covers Operator Login Name, Queue Name, Total 

Talk Time, Average Answered Talk and Longest Talk Time. A single line of information is 

provided for each Operator. Totals are given for each Date/report. 
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Field Names Description 

User Login Name Logged in user’s name. 

Queue Name The Queue assigned to that selected user. 

Total Queue Calls 

Total Talk Time The total talk time by an user for inbound calls. 

Average Answered Talk Average Talk time for Answered Call. 

Longest Talk Time Longest Talk time for Answered Call in Console Connect. 

Total number of Queue Calls. 

 

The following selections are available for this report: 

Operator(s) is to be selected by the user before running the report. 

Queue (s) is to be selected by the user before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.3.4.4 CO04- Operator Activity Report 

This is a summary report of Operator(s) Activity in Console Connect, covering a specified date. 

The information provided covers Call Time, Call Event, Reason, Alerting Time, Connected Time, 

CLI and Call Type. A single line of information is provided for each Call 

 

Field Names Description 

Time The Time when an event has occurred related to the operator. 

Event Event that has occurred. Like, login, logout, unavailable etc. 

Alerting Time A counter that will continue to display the time with the call, as it 

increases. 

Connected Time The time the operator was connected with the call. 

CLI Caller’s Line Identification for the incoming external call. 

Call Type Internal or External 
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The following selections are available for this report: 

Operator(s) is to be selected by the user before running the report. 

Operator Activity type to be selected by the user before running the report.  

Choices are; All Information, Login Logout only and Call Information. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 

 

7.3.4.5 CO05- Operator Outbound Calls CLI 

This is a summary report of Operator(s) Outbound calls during login session, covering a specified 

date. The information provided covers Start Time, End Time, Talk Time, CLI, DDI and Call Status. 

A single line of information is provided for each Call. Totals are given for each Operator/report. 

 

Field Names Description 

Start Time Start time of the outbound call. 

End Time End time of the outbound call. 

Talk Time Talk time of an operator 

CLI Caller’s Line Identification for the incoming external call. 

DDI Direct Dial Inbound: The number the caller of the abandoned call 

dialled. 

Call Status Status of the outbound call. 

 

The following selections are available for this report: 

Operator(s) is to be selected by the user before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 
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7.3.4.6 CO06 - Operator Activity Summary 

This is a summary report of User(s) Activities during login session, covering a specified date 

range. A single line of information is provided for each User. Totals are given each User/report. 

 

Field Names Description 

Operator Login Name Name of the Operators selected for the report. 

Total  Total Inbound calls for Operators 

Total Login Time Total Login Time for the Operators while in Login Session. 

Average Talk Time Average Talk Time for the Operators while in Login Session. 

Longest Talk Time Longest Talk Time for the Operators while in Login Session. 

Total No of outbound calls Total number of outbound calls while in Login session. 

Total Talk Time Outbound Total Talk Time for outbound calls for the Operators while in 

Login Session. 

Average Talk Time 

Outbound 

Average Talk Time for outbound calls for the Operators while in 

Login Session. 

Longest Talk Time Outbound Longest Talk Time for outbound calls for the Operators while in 

Login Session. 

 

The following selections are available for this report: 

User(s) is to be selected by the user before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.4 Appendix 4: Voice Connect Reports 

7.4.1 Voice Connect Graphical Analysis 

A wide range of historical graphs is also available in Voice Connect section. These cover all areas 

of Voice Connect, and are defined in the following folders: - 

1. Overview  

2. Session   
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3. Night Service  

4. Overflow  

 

7.4.1.1 Overview Graphs 

Report – VG01: Voice port Utilization for a Period. 

This graph shows the Voice port Utilization for a specific Period selected. To run a graph, double 

click on the graph report name in the Description panel. Data on this report is shown as Time 

intervals on X-Axis and Information (% of Voice port Utilization) on Y-Axis. Available Graph types 

are Bar and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and 

Year. 

 

Report – VG02: Voice Calls for a Period. 

This graph shows the Total Voice Connect Calls for a specific Period selected. To run a graph, 

double click on the graph report name in the Description panel. Data on this report is shown as 

Time intervals on X-Axis and Information (Calls for Voice Connect) on Y-Axis. Available Graph 

types are Bar and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months 

and Year. 

 

7.4.1.2 Session Graphs 

Report – VCQG01 – VCQG05: Call Details by Time Period. 

There are 11 session graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 11 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar and Line. 

Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year. Choices in the 

Call Details include: - 

1. No. of Calls 

2. Answered Calls 

3. Abandoned Calls 

4. Average duration for Answered Calls 

5. Longest duration for Answered Calls 
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Report – VCQG14 – VCQG18: Consolidated Call details by session. 

There are 11 session graphs available. To run a graph, double click on the graph report name in 

the Description panel. There are 11 choices (as Call details) given to the user in the drop down 

box in Graph setting. Selecting different Information as Call Details will change the graph report 

produced by the user. Data on this report is shown as Time intervals on X-Axis and Information 

(Call Details type as selected by the user) on Y-Axis. Available Graph types are Bar, Pie and Line. 

Choices in the Call Details include: - 

1. No. of Calls 

2. Answered Calls 

3. Abandoned Calls 

4. Average duration for Answered Calls 

5. Longest duration for Answered Calls 

 

7.4.1.3 Night service Graphs 

Report – VCNG01: No. of Night Service Calls by Time period. 

This Graph report shows the total number of Night Service Calls for a session. To run a graph, 

double click on the graph report name in the Description panel. Data on this report is shown as 

Time intervals on X-Axis and number of Night Service calls on Y-Axis. Available Graph types are 

Bar and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One session is selectable before running a graph.  

Report Date range is selectable. 

 

7.4.1.4 Overflow Graphs 

Report – VCOG01: No. of Overflow Calls In. 

This Graph report shows the total number of overflowed calls in a session. To run a graph, 

double click on the graph report name in the Description panel. Data on this report is shown as 

Time intervals on X-Axis and number of overflowed calls on Y-Axis. Available Graph types are Bar 

and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One session is selectable before running a graph.  

Report Date range is selectable. 
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Report – VCOG02: No. of Overflow Calls Out. 

This Graph report shows the total number of overflowed calls out of the session. To run a graph, 

double click on the graph report name in the Description panel. Data on this report is shown as 

Time intervals on X-Axis and number of overflowed calls on Y-Axis. Available Graph types are Bar 

and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One session is selectable before running a graph.  

Report Date range is selectable. 

 

Report – VCOG03: Percentage of Overflow Calls - Calls In. 

This Graph report shows the Percentage of overflowed calls in a session. To run a graph, double 

click on the graph report name in the Description panel. Data on this report is shown as Time 

intervals on X-Axis and Percentage of overflowed calls on Y-Axis. Available Graph types are Bar 

and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months and Year.  

One session is selectable before running a graph.  

Report Date range is selectable. 

 

Report – VCOG04: Percentage of Overflow Calls - Calls Out. 

This Graph report shows the total Percentage of overflowed calls out of the session. To run a 

graph, double click on the graph report name in the Description panel. Data on this report is 

shown as Time intervals on X-Axis and Percentage of overflowed calls on Y-Axis. Available Graph 

types are Bar and Line. Time intervals can be 15 Minutes, Hours, Days, week, Month, 3 months 

and Year.  

One session is selectable before running a graph.  

Report Date range is selectable. 

 

7.4.2 Overview 

There are seven historical text reports present in Voice Connect Overview folder. Data shown in 

these reports is based on calls made through the Voice Connect module of Arc Connect Suite. 
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7.4.2.1 VC01-Incoming Calls By Date 

This is a summary report of Incoming Call Data, for a specified date range. A single line of 

information is provided for each date. 

 

Field Names Description 

Total Calls Total number of call entered in Voice Connect during the Date 

range selected. 

Answered Calls Total number of incoming calls answered in Voice Connect.  

Abandoned Calls Total number of incoming calls abandoned in Voice Connect. 

% Answered Total number of incoming calls answered in Voice Connect /Total 

numbers of calls * 100 

% Abandoned Total number of incoming calls abandoned in Voice Connect 

/Total numbers of calls * 100 

Average Wait This is the average time a caller has waited before the Voice 

Connect answered the call. 

Average Answered Talk 

Time 

Average Talk time for Answered Call in Voice Connect. 

Average Wait of Abandoned 

Calls 

This is the average time a caller has waited before the call is 

Abandoned. 

Longest Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 
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Answer Time Profile  These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait 

 

The following selections are available for this report: 

Date Selection: From: Start Date; To: End Date. 

 

7.4.2.2 VC02-Total Incoming Calls by Time 

This is a summary report of Incoming Call Data, covering a specified date range. A single line of 

information is provided for each hour. 

 

Field Names Description 

Total Calls Total number of call entered in Voice Connect during the hour. 

Answered Calls Total number of incoming calls answered in Voice Connect.  

Abandoned Calls Total number of incoming calls abandoned in Voice Connect. 

% Answered Total number of incoming calls answered in Voice Connect /Total 

numbers of calls * 100 

% Abandoned Total number of incoming calls abandoned in Voice Connect 

/Total numbers of calls * 100 
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Average Wait This is the average time a caller has waited before the Voice 

Connect answered the call. 

Average Answered Talk 

Time 

Average Talk time for Answered Call in Voice Connect. 

Average Wait of Abandoned 

Calls 

This is the average time a caller has waited before the call is 

Abandoned. 

Longest Wait Among all the answered calls, the longest wait a caller has to 

bear before the call was answered. 

Answer Time Profile  These are the five stats maintained for all the answered call in 

term of wait. 

� 10: % Calls answered within 10 seconds. 

� 20: % Calls answered between 10 to 20 seconds. 

� 30: % Calls answered between 20 to 30 seconds. 

� 40: % Calls answered between 30 to 40 seconds. 

� 40: % Calls answered after 40 seconds of wait 

 

The following selections are available for this report: 

Date: For: Date of the Report. 

 

7.4.2.3 VC03 - Abandoned Calls CLI Report 

This is a report that gives details of all abandoned calls, for a specific date. Totals are given for 

all sessions selected in this report.  

 

Field Names Description 

Time of Call The Time when the call first rang in Voice Connect. 

Queue Name of the Voice Session in which call is being handled. 

CLI  Caller’s Line Identification for the incoming external call. 
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DDI Direct Dial Inbound: The number the caller of the abandoned call 

dialled. 

Ring Duration The Total Time duration for which the call remained in Voice 

Connect. 

 

The following selections are available for this report: 

Date: For: Date of the Report. 

Time: From: Start Time; To: End Time. 

 

7.4.2.4 VC04 - Call Routing by Date 

This is a summary report for each Call Filter used for routing calls into voice sessions, for a 

specified date range. Totals are given for each Call Filter type and for each date in selected date 

range. 

 

Field Names Description 

Call Filter Number of the Filter applied to the Group of Calls. 

Routing Tag Routing Tag with the applied filter. 

Reference assigned to the 

filter 

This is the name of the Voice Session on which the filter is 

applied. 

Total Calls Total number of call entered in Voice Connect during the Date 

range selected for the Report. 

Answered Calls Total number of calls answered in Voice Connect. 

Abandoned Calls Total number of calls abandoned in Voice Connect. 

Overflowed Calls Total number of calls overflowed to a device or External number 

from Voice Connect. 
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Night Service Calls The total number of calls that have fallen in the Break Hours of 

the Voice Connect voice sessions. 

% Answered Total number of calls answered in Voice Connect /Total numbers 

of calls * 100. 

% Abandoned Total number of calls abandoned in Voice Connect /Total 

numbers of calls * 100. 

 

The following selections are available for this report: 

Date Selection: From: Start Date; To: End Date. 

 

7.4.2.5 VC05 - Call Routing by Time 

A summary report for each Call Filter used for routing calls into Voice sessions, for a specific 

date. A single line of information is provided for each hour. Totals are given for each Call Filter 

type and for the selected date. 

 

Field Names Description 

Call Filter Number of the Filter applied to the Group of Calls. 

Routing Tag Routing Tag with the applied filter. 

Reference assigned to the 

filter 

This is the name of the Voice Session on which the filter is 

applied. 

Total Calls Total number of call entered in Voice Connect during the hour. 

Answered Calls Total number of calls answered in Voice Connect. 

Abandoned Calls Total number of calls abandoned in Voice Connect. 
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Overflowed Calls Total number of calls overflowed to a device or External number 

from Voice Connect. 

Night Service Calls The total number of calls that have fallen in the Break Hours of 

the Voice Connect voice sessions. 

% Answered Total number of calls answered in Voice Connect /Total numbers 

of calls * 100. 

% Abandoned Total number of calls abandoned in Voice Connect /Total 

numbers of calls * 100. 

 

The following selections are available for this report: 

Date: For: Date of the Report.  

 

7.4.2.6 VC06 - Voice Port Utilization for a period 

This is a summary report showing the Voice port Utilization for a selected period. Totals are given 

for each voice Port used and for the Report. 

Field Names Description 

Port number Number of Voice Port used. 

% Used Time the selected voice session has used this port/Total usage of 

this port * 100. 

% Unused Time the selected voice session has not used this port/Total 

usage of this port * 100. 

Processing Duration Total Time for which the Voice Connect has used the port. 

Calls Processed Total number of calls being processed by the Voice Connect 

using the voice port. 

 

The following selections are available for this report: 

Date: For: Date of the Report.  
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7.4.2.7 VC07 - Voice Calls for a period with session break down 

This is a summary report showing the calls processed by Voice Connect, for a specific date. A 

single line of information is provided for each hour. Totals are given for each Hour and for the 

selected date. 

 

Field Names Description 

Session Name Voice Sessions selected by the user for the report. 

% Processed % Call processed by the voice session /Total calls in Voice 

Connect * 100. 

% Unprocessed % Call unprocessed by the voice session /Total calls in Voice 

Connect * 100. 

Calls Processed Total number of calls processed by the Voice Session. 

Calls Not Processed Total number of calls in Voice Connect not processed by the 

Voice Session.  

 

The following selections are available for this report: 

Date: For: Date of the Report.  

7.4.3 Session 

There are seven historical text reports present in Voice Connect Session folder. Data shown in 

these reports is based on the calls handled by voice sessions configured in Voice Connect 

module.  

 

7.4.3.1 VR01 - Incoming Calls by Session 

This is a summary report of Incoming Calls, for a specified date range. A single line of 

information is provided for each Voice Session. 
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Field Names Description 

Total Calls Total number of calls entered in Voice Connect during the Date. 

Answered Calls Total number of calls answered in Voice Session. 

Abandoned Calls Total number of calls abandoned in Voice Session. 

% Answered Total number of calls answered in Voice Session/Total numbers 

of calls * 100 

% Abandoned Total number of calls abandoned in Voice Session/Total numbers 

of calls * 100 

Average Answered Wait This is the average time a caller has waited before the call is 

answered. 

Average Answered Duration Average Talk time for Answered Calls for Session. 

Average Wait of Abandoned 

Calls 

This is the average time a caller has waited before the call is 

Abandoned. 

Longest Wait Among all the answered calls in a Voice Session, the longest wait 

a caller has to bear before the call was answered. 

 

The following selections are available for this report: 

Session (s) is selectable before running the report. 

Arrival or Delivery Session type is selectable before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.4.3.2 VR02 - Total Incoming Calls by Session/Time 

This is a summary report of Incoming Calls for a session, for a selected date. A single line of 

information is provided for each hour. 

<<TOC 

   

    182 



 

Field Names Description 

Total Calls Total number of calls entered in Voice Connect during the hour. 

Answered Calls Total number of calls answered in Voice Session. 

Abandoned Calls Total number of calls abandoned in Voice Session. 

% Answered Total number of calls answered in Voice Session/Total numbers 

of calls * 100 

% Abandoned Total number of calls abandoned in Voice Session/Total numbers 

of calls * 100 

Average Answered Wait This is the average time a caller has waited before the call is 

answered. 

Average Answered Duration Average Talk time for Answered Calls for Session. 

Average Wait of Abandoned 

Calls 

This is the average time a caller has waited before the call is 

Abandoned. 

Longest Wait Among all the answered calls in a Voice Session, the longest wait 

a caller has to bear before the call was answered. 

 

The following selections are available for this report: 

Session (s) is selectable before running the report. 

Arrival or Delivery Session type is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 
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7.4.3.3 VR03 - Session Activity by Time 

This is a summary report of activities for a voice session, covering a specified date. A single line 

of information is provided for each Call. 

 

Field Names Description 

Session name Name of the selected voice session for this report. 

Start Time Start time for the Call. 

End Time End time of the call. 

Talk Time Total talk time for the call. 

CLI Caller’s Line Identification for the incoming external call in the 

Voice Session. 

DDI Direct Dial Inbound. The number the caller dialled. 

Destination Final destination of the call where it was answered. 

Outcome of the Call The final output of the call, if answered or abandoned. 

 

The following selections are available for this report: 

Session is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 

 

7.4.3.4 VR04 - Overflowed Calls by Date 

This is a summary report of overflowed calls for a Voice Session, for a specified date range. A 

single line of information is provided for each Session/date. 

 

Field Names Description 

Voice Session It displays the name of the Voice Session for which the report is 

generated. 

Total Session Calls The total number of incoming calls in a Voice Session. 

Total Overflow In The total number of calls overflowed in a respective Voice 

Session. 
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Overflow In The number of calls overflowed in the selected Voice Session 

from other call Queues during business hours. 

Overflow out Time Limit It displays the number of calls, which were overflowed out to the 

other Queues. Reason being that the time for a call waiting to be 

answered exceeded the limit. 

Overflow out Session Limit It displays the number of calls, which were overflowed out to 

other Queues. Reason being that the Voice Session could take no 

more calls. 

Overflow out No Users  

Total Total number of calls Overflowed Out of the Voice Session. 

Overflow out Destination  The destination to which the calls were overflowed. 

% In The calculated percentage of the Overflowed In calls. 

% Out The calculated percentage of the Overflowed Out calls. 

 

The following selections are available for this report: 

Session (s) is selectable before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.4.3.5 VR05 - Overflowed Calls by Time 

This is a summary report of overflowed calls for a session, for a selected date. A single line of 

information is provided for each hour. 

 

Field Names Description 

Overflow out Destination  The destination to which the calls were overflowed. 

Voice Session It displays the name of the Voice Session for which the report is 

generated. 

Total Session Calls The total number of incoming calls in a Voice Session. 

Total Overflow In The total number of calls overflowed in a respective Voice 

Session. 
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Overflow In The number of calls overflowed in the selected Voice Session 

from other call Queues during business hours. 

Overflow out Time Limit It displays the number of calls, which were overflowed out to the 

other Queues. Reason being that the time for a call waiting to be 

answered exceeded the limit. 

Overflow out Session Limit It displays the number of calls, which were overflowed out to 

other Queues. Reason being that the Voice Session could take no 

more calls. 

Overflow out No Users  

Total Total number of calls Overflowed Out of the Voice Session. 

% In The calculated percentage of the Overflowed In calls. 

% Out The calculated percentage of the Overflowed Out calls. 

 

The following selections are available for this report: 

Session (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 

 

7.4.3.6 VR06 - Night Service Calls by Date 

This is a summary report of Night Service (Break Hours) calls for a Voice Session, for a specified 

date range. A single line of information is provided for each date. 

Field Names Description 

Total Voice Session Calls The total number of calls in the voice session. 

Overflow In  The number of calls overflowed in from other call Queues during 

business hours. 

Overflow Out The number of calls overflowed out to other call Queues during 

business hours. 

% Calls In The calculated percentage of the calls overflowed in. 

% Calls Out The calculated percentage of the calls overflowed Out. 

Night Service Destination The forward destination for the calls that is overflowed during 

the break hour of the selected voice session. 
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The following selections are available for this report: 

Session (s) is selectable before running the report. 

Date Selection: From: Start Date: To: End Date. 

 

7.4.3.7 VR07 - Night Service Calls by Time 

This is a summary report of Night Service (Break Hours) calls for a Voice Session, for a specified 

date. A single line of information is provided for each hour. 

 

Field Names Description 

Night Service Destination The forward destination for the calls that is overflowed during 

the break hour of the selected voice session. 

Time The hour for the report. 

Total Voice Session Calls The total number of calls in the voice session. 

Calls In  The number of calls overflowed in from other call Queues during 

business hours. 

Calls Out The number of calls overflowed out to other call Queues during 

business hours. 

% Calls In The calculated percentage of the calls overflowed in. 

% Calls Out The calculated percentage of the calls overflowed Out. 

 

The following selections are available for this report: 

Session (s) is selectable before running the report. 

Date: For: Date of the Report. 

Time Selection: From: Start Time; To: End Time. 

<<TOC 

Arc Connect Supervisor User Guide 

Version 4.1   187 



 

7.5 Appendix 5: Drill Down Chart for Data Windows 

Table given below shows the Details about fields in the Data Statistics List and drill down for 

each type of Report. 

Data Window 

type 

Available Data 

Levels 

Data Item type Data Statistics type 

Numeric 

Time Based 

Queues 

All 

Numeric 

Time Based 

System 

Users 

All 

Numeric 

Time Based 

Queues 

All 

Numeric 

Time Based 

Module 

Users 

All 

Numeric 

Time Based 

Queues 

All 

Numeric 

Time Based 

Tree Table 

Queue Users 

Users 

All 
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Numeric 

Time Based 

Queue Queues 

All 

Numeric 

Time Based 

Users Users 

 

All 

Numeric 

Time Based 

Queues 

All 

Numeric 

Time Based 

Standard Table 

Queue Users 

Users 

All 

Numeric 

Time Based 

Queues 

All 

Numeric 

Time Based 

System 

Users  

All 

Numeric Queues 

All 

Numeric 

Time Based 

Call Table 

Module 

Users 

All 

Time Based 
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Numeric 

Time Based 

Queues 

All 

Numeric 

 Queue Users 

Users 

All 

Numeric Queue Queues 

Time Base 

Numeric User Users  

Time Based 

Numeric Queues 

Time Based 

Numeric 

Bar Graph 

Queue Users 

Users 

Time Based 

Numeric Queue Queues 

Time Base 

Numeric User Users  

Time Based 

Queues Numeric 

Pie Graph 

Queue Users 

Users Time Based 

Numeric Queue Queues 

Time Base 

Numeric User Users  

Time Based 

Queues Numeric 

Line Graph 

Queue Users 

Users Time Based 

Time Based 
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Numeric Queue Queues 

Time Based 

Numeric User Users  

Time Based 

Numeric Queues 

Time Based 

Numeric 

Frames 

Queue Users 

Users 

Time Based 
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Section 9: Glossary 

Abandoned Calls These are the calls that were not answered in Arc System. 

Active Calls 

Answered Calls 

The name of the original queue, to which the call came into. 

Call Status 

Consult Transfer 

These are the calls that are in progress. 

Calls that have been answered by a user. 

Arrival Queue 

Alerting Time This is the total length of time since the call was passed to the user’s 

extension. Therefore the alerting time will apply whatever the state of 

the call - Ringing, Held or Current - until the call has been cleared. 

Auto Answer Functionality of Phone set with which it answers the call automatically. 

Blind Transfer Transferring a call to a user, Device or queue without consultation. 

Call Origin Whether the call is an internal or external call. (INT or EXT) 

Call Queuing The ability for a physical phone to have several calls stacked on the line 

waiting to be answered. 

It tells what is currently happening to the call.  It can be Ringing, Held or 

Connected. 

Call Type Whether the call is an inbound, outbound or a transferred call. 

(IN/OUT/TFR) 

CLI Number The caller's number, Caller’s Line Identification. 

CLI Tag An additional piece of useful information added to the CLI. This could be 

the name of the customer. 

Transferring a call to a user or Device after consultation. 

Delivery Queue This is the queue from which the call is being delivered to the user. In 

some instances the arrival and the delivery queue may be the same. 

However, where a call has been redirected or transferred to another 

queue, the delivery queue will be different.       

DDI Number The number that the caller dialled. 

DDI Tag An additional piece of useful information added to the DDI. 

Directory 

Numbers 

These are the extension numbers of the call centre. The Directory 

contains all of the extensions and data that the operator will see both in 

their Busy Lamp and Internal Extension displays. 
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Directory Groups Directory Groups reflect what operators see in their Busy Lamp Field. 

Depending on the business scenario in place, these groups have 2 

functions. In a single business scenario a Default list of all extensions 

may suffice, allowing the operator to see all extensions. (For 

performance purposes an upper limit of 400 extensions should not be 

exceeded.) In a multi-tenant environment a Directory Group could be set 

up for each serviced company, so that when a call arrives for that 

company, the operator sees only the relevant extensions in their display. 

External CLI 

Details 

These are contact details for the numbers outside the Call centre. 

External CLI Details are the Contacts that operators see in their External 

Directory Field. 

Night Service This facility allows you to take the queue out of operation at certain 

times of the day. During this time, calls are routed to some other 

destination.  For example, if you close down the 'Accounts service' queue 

every day at 7pm, beyond that time calls can be routed to a destination - 

device or another queue. 

Outbound Call Call that has been dialled out from the call center. 

Inbound Call Call that has been made to the call center. 

Queue Thresholds Queue Threshold are set so that a Supervisor can see a visual view of 

where problems may be occurring within Call Connect. 

Report code Each report has a unique code, which helps you to identify each the 

report, or graph, that has been used. 

Routing Tag A piece of information, which comes in with the call from the call queue.  

It may provide some information about the nature of the call. For 

example, the call may be associated with a particular marketing 

campaign.  

Routing Tag 

Groups 

Routing Tag Groups allow a Routing Tag to be attached to a Directory 

Group. In a Multi-Tenant scenario this allows an operator to only see 

relevant devices. 

System Monitor The ‘System Monitor Template’ window gives you an overall Activity of all 

the Queues, Userss, and Calls in your call centre. 
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Average 

Answered Wait 

Time 

Average time the caller had to wait before his call was received. 

Average Wait All 

Calls 

Average wait time for all calls in queue. 

Talk Time This specifies the time interval in which the user is attending to a caller. 

Queue Call Inbound calls. 

Queue Talk Time Inbound call talk time. 

Break Hour This specifies the time interval for which the queue/user will not operate 

calls. 

Current Device 

Status 

Current status of a device. 

Current Status Current call status 

Not Ready Time The time interval in which the user is not ready to receive any calls. 
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